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, INTRODUCCION ,
ESTADISTICA DESCRIPTIVA (CONCEPTOS BASICOS)

La estadistica tiene como finalidad estudiar detalladamente las caracteristicas de una muestra
de datos. Este estudio se realiza a través de variables. Variables: Son cantidades que pueden
tomar distintos valores de un momento a otro, y son propiedades de los casos que pueden
tomar distintos valores. Ej. En la investigacién de ejemplo se estudian las caracteristicas de una
muestra de 150 sujetos. Se estudian siete variables: Edad, sexo, estatus, region, ci, estatura y
peso. La edad es una propiedad (tiempo vivido) de los casos (sujetos en este caso) que
pueden tomar distintos valores. Sexo es una variable porque puede tomar distintos valores:
hombre o mujer.

Variables y Casos:Todo conjunto de datos puede ser visto como una matriz. Las filas se
corresponden con los distintos sujetos o unidades de investigacion, sobre los que se han
realizado las distintas observaciones. Esta Ultimas se corresponden con las columnas. Los
sujetos (filas) suelen denominarse casos y las observaciones (columnas) suelen denominarse
variables. A modo de ejemplo, por caso, dependiendo del estudio, puede entenderse un
paciente, o bien una muestra de laboratorio, 0 una visita médica o un episodio de recurrencia
de una enfermedad. Por variables, asociadas a los casos anteriores, puede entenderse el sexo
y la edad del paciente, la formula leucocitaria de la muestra de laboratorio, la fecha y presion
arterial medidas en una determinada visita médica. Es importante notar que, con frecuencia se
confunde, en este Ultimo caso, cual es el sujeto de andlisis, si el paciente con varios episodios
de recurrencia o cada episodio de recurrencia es un caso en si, pudiendo haber varios
episodios para un mismo paciente. La distincién de la unidad de analisis en cada situacion la
marcard el objetivo de la investigacion.

Tipo de variables

Cualitativas Cuantitativas
Contienen informacién cualitativa de los sujetos
denotando la cualidad o la categoria a la que

pertenece un sujeto.

individuo.

Miden la magnitud de una medida sobre un

Nominales

Ordinales

Escala

Las observaciones se
clasifican en categorias
(mutuamente
excluyentes y
colectivamente
exhaustivas) sin que
éstas tengan un orden
especifico (por ejemplo

los grupos sanguineos).

Un caso particular de
datos nominales es el
caso de los datos
dicotémicos en los que
existen solo dos
categorias (como por
ejemplo en el sexo).

En esta escala de medicién
no tiene sentido medir la
distancia entre posibles
valores de la variable ni se
pueden realizar operaciones
aritméticas con ellos pues
no toman valores numeéricos
especificos ni existe
proporcionalidad entre
categorias vecinas. Si
pueden sin embargo ser
ordenados pues existe una
relacion de orden entre las
distintas clases o
categorias. El prondstico de
una enfermedad (menos
grave, grave, mas grave) es
un dato medido en escala
ordinal.

Estas variables miden una magnitud de los sujetos
resultando en un valor numérico. Utilizan escalas
numeéricas y si tiene sentido medir la distancia que
hay entre posibles valores de los datos. En estas
variables cabe distinguir aquellos casos donde el
punto cero es arbitrario (medicion a nivel de
intervalo) como por ejemplo la temperatura, o
datos donde el cero es un punto fijo (nivel de
razén) como por ejemplo el peso o la glucemia. Si
bien el SPSS no hace distincién entre variables del
tipo escala, los procedimientos estadisticos
distinguen entre variables discretas y continuas.
En el primer caso el conjunto de posibles valores
de la variable es finito siendo en el segundo
continuo. Un ejemplo de variable discreta es el
ndmero de dias de ingreso en un Hospital, y un
ejemplo de variable continua es la glucemia.
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Tipo de Variables

Cualitativas o
Nominales
= Sus valores son

distintos.

Ej.
Sexo: hombre,
mujer
Regién: norte,
este, oeste, sur.
Se

mediante:

estudian

= La distribucion
de frecuencias

= La grafica de
barras o de
sectores

= Un estadistico
descriptivo: La

MODA.

Cuantitativas

= Sus valores son distintos y se pueden ordenar ( de mayor a menor).

Ordinales
= Valores distintos.
= Se pueden ordenar.
socioeconémico:

Ej- estatus

Medio, Bajo

Alto,

Se estudian con:

= Distribucién de frecuencias.

= Gréfica de sectores si hay pocos
valores distintos.

= Descriptivos: mediana, maximo,
minimo, rango o amplitud.

= Con mas de 10 valores distintos se
analizan como variables de
intervalo.

= En el caso de depuracion de items
de pruebas y encuestas se utilizan

indices de

los asimetria 'y

apuntamiento

De Intervalo
= Valores distintos.
= Se pueden
ordenar.
= Existe una unidad
comdan.
Ej- Cl

Ej.

De Razon
Valores distintos.
Se pueden ordenar.
Existe una unidad
comun.
Existe un cero real.

Peso, edad,

estatura

Se estudian con los mismos estadisticos:

= Histograma

= Descriptivos: media, desviaciéon tipica,

maximo,

minimo,

amplitud, los

coeficientes de asimetria y apuntamiento.

= Relaciones de las variables: Sexo, estatus; regiéon

Mediante: Tablas

cuadrado,Coef.

De contingencia, Phi,

de Chi

V de Cramer,

contingencia (Crosstabs),

Lambda. Grafica de Barras. Porcentaje por celdilla.

= Relaciones bivariadas: ci, peso y estatura

Mediante: Coeficiente de correlacion de

Pearson. Graficas de dispersion (Scatter).

Recta de regresion lineal.
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APLICANDO UN CUESTIONARIO

UNIVERSIDAD PRIVADA SAN PEDRO

Sr(a)(ta): Se solicita su valiosa colaboracion que nos permita recolectar datos para
analizarlos e interpretarlos de un Trabajo de Investigacion que favorecera a la ciudad
de Chimbote.

Escriba en el espacio en blanco o con la letra “X” segin corresponda.

GRACIAS POR SU COLABORACION

1.- N° de Identificacion de la encuesta. ............... (Valores del 001 al 150)

2.- Edad (en afos cumplidos): ......cccoeeeeeienennnn.
3.- Sexo: Hombre () Mujer ()

4.- Escriba solamente su primer 0 Unico NOMbBre: ........cccccceeeeeeiccennenee.

5.- En forma relativa indique el estatus socioecondémico en el que se ubicaria:

Alto () Medio ( ) Bajo ( )

6.- De las alternativa dadas ubique, la region o zona en que se ubica su domicilio:

Norte ( ) Este( ) Oeste () Sur( )

7.- Escriba el valor relativo de su cociente intelectual. (Escriba valores como

minimo desde 52 hasta un valor maximo de 159): ...................

8.- Estatura (en centimetros) : .......cccccvvvvvvvvvevevevinneninnnns

9.- Peso en kilogramos (Con aproximacion a un decimal): .................o.....
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PRACTICA N° 01: DEFINICION DE VARIABLES DEL CUESTIONARIO AL PAQUETE ESTADISTICO
1.- Ingrese al programa estadistico SPSS. Active la ventana Variable New. Nombre del archivo a Guardar: (Escriba su Apellido)

Mombre Tipo | Anchura | Decimales Etiquata | ‘alares | Ferdidos Columnas | Alineacidn | tedida ‘ =
1[iden Mumérico 3 0 Mimero de ide MNinguno 4 g Derecha Escala
2| edad Mumérico 2 0 Minguna -4 B Derecha Crdinal
3| sexn Mumérico 1 0 11, Hombra}... |9 B Derecha Crdinal
dnombra  |Cadena 10 0 Minguna Minguno 10 |zquierda Mominal
olestatus  |Mumérico 1 0 Estatus sociog {1, Alta).. 9 B Derecha Crdinal
B regidn Murmérico 1 0 11, Morte}... |9 B Derecha Crrdinal
7l Mumérica 3 1 Cociente intele Minguno 40 g Derecha Escala
B|estatura  Mumérico 3 0 Minguna -4 B Derecha Escala
9 peso Murmérico 3 1 Minguno A0 B Derecha Escala
Nombre Tipo Anchura | Decimales Etigueta Valores Perdidos Columnas |Alineaci6n Medida
. NUmero de Ninguno -9
Iden Numerico 3 0 identificacion del sujeto 8 Derecha Escala
edad Numerico 2 0 Ninguno -9 8 Derecha Ordinal
1 > Hombre
Sexo Numerico 1 0 9 8 Derecha Ordinal
2 2> Mujer
nombre |Cadena 10 Ninguno 10 Derecha Nominal
Estatus 1-> Alto
Estatus | Numerico 1 0 socioeconomico - 9 8 Derecha Ordinal
2 > Medio
3 =2 Bajo
1 - Norte
9
region Numerico 1 0 2 > Este 8 Derecha Ordinal
3 =2 Oeste
4 - Sur
ci Numerico 3 1 Cociente Intelectual NingunO -9.0 8 Derecha Escala
estatura | Numerico 3 0 Ninguno -9 8 Derecha Escala
peso Numerico 5 1 Ninguno -9.0 8 Derecha Escala
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PRACTICA N° 02: INGRESO DE DATOS

1.- Mediante trabajo en equipo (5 personas), ingresara al archivo que contiene la
definicién de las variables, debera dividir el trabajo para ingresar los datos de las 150
encuestas. Para lo cual copie el archivo (Ej. ALVA.SAV), en cada una de las
computadoras de los integrantes de su equipo. Luego cada uno, abrira el archivo ALVA
y podra ingresar, por ejemplo los datos de 30 casos. Cada alumnno grabara el archivo
por ejemplo, como: ALVA-(1-30); ALVA-(31-60); ALVA-(61-90); ALVA-(91-120); ALVA-
(121-150).
2.- Una vez ingresados todos los datos. Unir todos los archivos en uno solo. Una
(Merge File).Utilizara el menu: DATA---Merge Files --- Add Cases.
Guarde todos los datos ingresados en un solo archivo con el nombre, por ejemplo:
ALVA - (1-150). Cada integrante cambiara el nombre del archivo con su propio apellido,
quedara: MIAPELLIDO-(1-150)

DATOS RECOLECTADOS A PARTIR DEL CUESTIONARIO

APLICADO PARA UN TRABAJO DE INVESTIGACION.

IDEN [EDAD|SEXO| NOMBRE [ESTATUS|REGION| CI |ESTATURA|PESO
1 15 2 |Abigail 1 3 124 154 57.9
2 16 1 |Carlos 1 3 95 154 56.7
3 31 1 |Alberto 1 2 101 156 52.8
4 24 2 |Adela 2 3 116 184 104.2
5 24 1 |Luis 1 1 102 173 87.5
6 32 2 |Adelina 2 1 102 170 71.5
7 26 1 |Antonio 1 1 81 176 93.3
8 21 1 [Juan 1 4 109 188 99.2
9 22 2 |Adriana 2 4 61 169 76.6

10 18 2 |Agata 2 1 93 175 87.9
11 25 1 |Cosme 9 9 119 177 80.3
12 29 2 |Aida 3 1 52 181 82.3
13 25 2 |Alameda 1 1 128 164 61.8
14 19 1 [Juan 2 1 65 160 75.0
15 30 1 |Carlos 1 1 116 162 60.3
16 29 2 |Alana 1 1 65 156 53.9
17 29 1 |Jose 3 4 147 172 78.6
18 16 2 |Albertina 1 1 113 175 85.7
19 31 1 |Armando 1 3 99 168 75.4
20 18 1 |Constante 2 4 117 159 73.0
21 21 1 [Toribio 1 2 105 178 87.6
22 29 1 |Borja 1 2 92 174 74.2
23 23 2 |Alejandra 3 4 78 178 100.9
24 28 2 |Alicia 1 4 97 163 77.1
25 19 1 |Manuel 3 4 77 180 74.6
26 31 1 |Carlos 3 4 81 174 70.2
27 33 1 |Antonio 2 1 126 137 99.3
28 17 2 |Alma 1 3 95 153 62.1
29 34 2 |Almeda 2 1 122 168 77.4
30 20 2 |Almeria 1 2 85 161 67.9
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IDEN|EDAD|SEXO|NOMBRE |[ESTATUS|REGION| Cl |[ESTATURA| PESO
31 26 2 |Almira 1 3 123 270 86.8
32 25 1 |Jose 2 2 94 167 70.5
33 15 2 |Alvina 1 4 101 173 85.7
34 23 2 |Amalia 1 3 80 187 95.6
35 20 1 |Luis 1 3 95 161 65.5
36 34 1 |Hugo 1 1 110 172 81.4
37 23 2 |Amanda 2 3 -9 162 57.2
38 16 1 |Jose 3 3 88 166 64.1
39 19 2 |Ambar 2 2 75 170 78.5
40 19 1 |Julian 2 2 85 164 65.4
41 35 1 |Jeremias 3 2 75 176 82.6
42 30 1 |Manuel 3 1 90 177 82.1
43 29 2 |Anabel 2 3 70 164 69.9
44 32 2 |Anastasia 2 2 111 147 59.4
45 34 1 |Sergio 2 1 70 167 84.2
46 33 2 |Andrea 3 2 116 169 79.4
47 32 2 |Ana 2 3 159 155 55.1
48 18 1 [Sergio 2 3 145 163 71.3
49 23 1 |Norberto 3 2 65 164 72.8
50 28 1 |Gustavo 1 3 76 176 75.2
51 17 1 |Gustavo 1 1 106 161 75.9
52 27 1 |Manuel 1 3 74 174 82.4
53 22 2 |Angela 2 1 90 163 76.7
54 23 2 |Angélica 2 1 101 162 71.9
55 21 1 |Alberto 1 2 68 188 95.7
56 22 2 |Anselma 2 3 77 155 68.5
57 19 2 |Antonieta 1 4 95 141 54.4
58 22 1 |Antonio 1 3 95 184 90.1
59 30 1 |Jeremias 3 4 63 161 80.4
60 26 2 |Antonina 1 2 124 171 72.9
61 23 2 |Arabela 3 4 118 160 65.3
62 23 2 |Ariadna 1 1 101 163 67.8
63 24 1 |Gabriel 3 4 92 148 58.8
64 24 2 |Ariana 2 2 117 174 79.5
65 31 2 |Arlena 1 4 140 180 77.0
66 34 1 |Diego 1 1 102 191 99.5
67 20 2 |Arlinda 2 2 87 174 84.6
68 18 2 |Astra 1 2 88 158 68.5
69 21 1 |Diego 1 1 95 159 61.8
70 27 2 |Astrid 1 2 86 151 63.6
71 16 1 |Gabriel 1 4 87 159 54.0
72 33 2 |Atalanta 1 2 113 156 71.7
73 23 2 |Augusta 1 3 68 153 57.1
74 32 2 |Aurea 1 1 102 175 90.0
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IDEN|EDAD|SEXO|NOMBRE |[ESTATUS|REGION| CI[ESTATURA|PESO
75 20 2 |Aurora 2 1 74 173 73.1
76 15 1 |Nicomedo 3 1 94 154 68.8
77 26 1 |Nicolas 3 3 144 180 94.3
78 26 1 Juan 1 3 130 167 78.9
79 22 1 |Andrés 2 3 114 176 84.3
80 16 2 |Barbara 3 1 118 160 64.0
81 21 1 [Millan 2 4 118 186 86.7
82 28 2 |Beatriz 2 2 128 151 62.6
83 17 1 |Chema 1 3 102 161 59.8
84 16 2 |Benedicta 2 2 88 173 96.9
85 27 1 |Humberto 1 2 115 169 80.4
86 20 1 |Jose 1 2 86 161 64.7
87 20 2 |Betina 1 4 111 160 66.2
88 -9 2 |Bianca 3 2 96 157 53.5
89 28 2 |Bibi 1 3 146 165 74.0
90 20 1 |Felipe 1 1 99 191 94.1
91 15 1 |Antén 1 1 113 173 76.0
92 21 2 |Brigida 1 4 123 152 58.2
93 28 1 |Federico 1 1 76 131 93.7
94 28 2 |Camila 1 4 118 167 70.5
95 24 2 |Carlota 2 3 129 176 79.4
96 21 2 |Carola 2 3 116 161 69.1
97 16 2 |Carolina 1 3 107 175 88.7
98 20 1 |Luis 1 2 130 183 83.3
99 26 2 |Carula 1 4 98 162 75.5
100 | 24 1 Juan 1 2 111 168 72.8
101 | 33 1 |Juan 1 2 60 172 84.7
102 17 1 [Jose 1 1 125 183 86.2
103 | 29 1 |Fadrigue 2 1 69 179 95.1
104 21 2 |Carolona 1 4 69 160 78.7
105 | 30 1 |Roberto 1 1 100 184 96.7
106 18 1 |Jose 2 3 121 187 94.8
107 | 33 1 |Alberto 1 2 140 175 84.5
108 | 33 1 |Emilio 1 1 110 172 79.0
109 | 21 2 |Caroline 1 3 140 157 71.6
110 | 20 2 |Carmela 3 4 141 188 92.0
111 21 2 |Casandra 1 2 108 176 81.4
112 | 20 2 |Catia 3 1 106 173 79.6
113 26 2 |Celeste 1 1 135 166 77.6
114 25 1 |Hugo 2 1 100 179 95.4
115 | 30 2 |Caridad 3 4 99 165 87.8
116 19 2 |Charo 3 2 154 168 72.9
117 15 1 Juan 3 3 136 164 75.5
118 | 26 2 |Clara 3 2 86 159 57.7
119 | 27 2 [Clarisa 1 4 93 158 59.4

Dr. Antonio Alva Santos aalval959@yahoo.es Pag. 7de 70



Guia de SPSS Facultad de Ingenieria

IDEN|[EDAD|SEXONOMBREESTATUS|REGION| CI ESTATURA|PESO
120 | 19 2 |Claudia 2 3 112 180 97.1
121 | 28 1 |Niobio 1 3 101 175 82.4
122 | 22 2 |Conchita 1 3 62 162 77.0
123 | 30 1 |Nobel 2 1 59 174 88.4
124 | 33 2 |Consuelo 1 3 62 162 77.0
125 | 23 1 |Julian 3 3 75 161 69.9
127 | 34 2 |Dalida 1 4 93 170 74.0
128 | 34 1 |Juan 3 2 147 179 87.5
129 | 18 1 |Jose 2 4 97 152 50.4
130 | 33 1 |Alberto 1 4 118 184 94.5
131 | 24 2 |Daniela 2 3 85 170 62.9
132 | 16 1 Jonas 2 3 116 172 81.3
133 | 19 2 |Debora 1 2 127 168 79.3
134 | 25 2 |Diana 3 2 109 164 73.5
135 | 27 1 |Julian 1 1 61 182 93.4
136 | 32 2 |Dominga 3 4 87 164 67.7
137 | 24 2 |Dorotea 2 1 93 171 81.6
138 | 26 1 |Julio 1 2 89 172 72.6
139 | 16 2 |Dulcinea 3 3 100 166 72.2
140 | 33 1 |Martin 2 3 111 171 85.0
141 | 23 1 |Manuel 3 1 104 160 75.2
142 | 17 2 |Elena 2 2 127 165 65.8
143 | 21 1 |Manel 1 1 124 174 77.9
144 | 22 1 |Jordi 1 1 109 166 75.0
145 | 32 2 |Eloisa 3 3 110 157 59.0
146 | 27 1 |Aitor 1 3 100 179 91.5
147 | 29 1 |Lumbago 1 1 97 190 92.7
148 | 20 1 |yul 2 2 80 174 79.3
149 | 27 1 |Honorio 3 1 107 190 90.7
150 | -9 1 Roberto 9 2 128 160 -9.0

NOTA:

e Debera tener una copia de seguridad de su archivo que contiene los 150 registros.
e Cualquier error cometido por alguno de los integrantes de su grupo, se reflejara en
los resultados al trabajar en el programa SPSS.
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PRACTICA N° 03

CREACION Y TRANSFORMACION DE VARIABLES
Abra el archivo MIAPELLIDO.sav: File > Open. Busca el archivo: MIAPELLIDO.sav.
Luego Abrir.
FUNDAMENTO: Los datos directos necesitan en muchas ocasiones ser transformados
antes de llevar a cabo los analisis estadisticos. Se pueden realizar con las opciones del
menu Transformar (Transform) o con lenguaje de comandos SPSS.
RECODIFICACION DE VARIABLES (RECODE).
Elija el mena Transformar - Recodificar (Transform -> Recode). Existen dos
posibilidades: “En distintas variables” recodifica la variable y crea una variable nueva
con esta recodificacion; y la opcidén “En las mismas variables” recodifica la variable, es
decir, los datos originales de la variable se sustituyen por los nuevos.
1.- RECODIFICAR de la variable REGION sus alternativas ESTE y OESTE a una

sola con el nombre CENTRO creando una nueva variable con el nombre
NREGION con esta recodificacion.
Variable: REGION Valores recodificados en la Variable: NREGION
Value Value Label Antiguos =2 Nuevos Value Label (Etiquetas)
(Valor) (Etiquetas) (Old = New)
1 Norte 1->1 1 - Norte
2 Este 222 2 = Centro
3 Oeste 322 3 2> Sur
4 Sur 4->3

PASOS A SEGUIR:
a) Transformar - Recodificar - En distintas variables. (Transform-Recode-Into Different
Variables...).
b) Clic en REGION y en el botdn central de Transferencia. En el recuadro Nombre (Name)

escriba: NREGION. Clic en cambiar (Change). En Label: Nueva region
i+ Hecode into Different ¥anables

Murmeric Yanable -» Output Y ariable:

@) Mumero de identificac - - Output % ariable

> edad i M ame:

> semo Inregién Change |
(4} nombre Label:

4 Estatus socioecondrmi I_N Ueva region

4 Cociente intelectual [o

@) eztatura
> peso

Old and Mew Yalues. .. |

] | Eastel Eesetl Eancell Help |

c) Clic en valores antiguos y nuevos (Old and New Values)

d) En la seccion Valor antiguo (Old Value) situarse en la casilla Valor (value) y escribir el
valor antiguo: 1

e) En la seccién Valor nuevo (New Value) situarse en la casilla Valor (Value) y escribir el

nuevo valor: 1
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Haga clic en el botén afiadir (Add). La recodificacion se habra escrito en la seccion
Antiguo > Nuevo (Old-> New).

Repita los pasos d, e y f para los valores antiguos 2 y 3. Escriba como valor nuevo (New
value) 2 para ambos casos.

Repita los pasos d, e y f para el valor antiguo 4 y escriba 3 como nuevo valor.
Pulse el botdn continuar (Continue) y aceptar (OK).
Recode into Different ¥Yariables: Old and New Yalues Ed
— 0ld Walue Mew Walue
i+ Walue: |4 [y "v"a_lue:|3 £ Spstem-mizzing
= System-missing " Copy old value(z]
" System- or user-missing Qld - Mew:
" Range: Add T 1
I— I— |__I 22
gt Ehatige | 32
i~ Range; —
[Lavest thrauat I HEMEyE |
" Range: [~ Output vanables are strings it IE:
I trawgh figtiest = | Eorwert numene shifas e numters (S
Al gther values Continue | Cancel Help |

Finalmente en la ventana editor de datos, haga doble clic en la nueva variable
NREGION.

Edita Type: Width:2 y Decimal places: 0O;
Para las etiquetas, clic en la opcién LABEL (Etiqueta) y cambie los valores de esta
nueva variable asi: Variable label: Nueva Regién. Value:1, Value label:Norte; Value:2,

Value label:Centro, Value:3, Value label:Sur. Clic en continuar y aceptar (OK).

Define Labels: nregidn Ed
Wariable Label: |Nueva reqgian Cantinue

—“alue Labels

W alue: |3

Walue Label; ISurI

Add I 1="Haorte"

2 ="Centro"
[Efiarme |
Hemoye |

Cancel

Help

4

Para missing values. Escriba: 9 dentro del recuadro de Discrete missing values. Corrija
en la tabla de datos, en caso de haber algun valor perdido, escribiendo: 9

Para hacer otra recodificacion diferente con otra variable. Clic en el boton Reset

File> Save as: MIAPELLIDO.SAV.
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RECODIFICACION DE RANGO DE VALORES.
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2.- Recodificar la variable EDAD (continua) en grupos de edad del archivo: ROSA- (1-
150).SAV, de acuerdo a la siguiente tabla:

EDAD

Del menor a 20 De 20 a 25

De 25 a 30

De 30 al mayor

NEDAD

1 2

3 4

» Transformar - Recodificar = En distintas variables. (Transform-Recode-Into
Different Variables...).

» Para hacer otra recodificacion diferente con otra variable. Clic en el boton Reset

= Clic en EDAD y en el boton central de Transferencia. En el recuadro Nombre
escriba: NEDAD. Clic en Cambiar (Change). En Label: Nueva edad.

+ Recode into Different ¥arnables x

& Nomero de identificaci

> sevo

(AL rombre

> Estatus socioecondmi
A regidn

& Cociente intelectual [o

@) esztatura

Murmenc Yanable -» Output Yanable:

— Dutput Y ariable
Marme:

Inedad LChange |
Label:

INueva edad

> peso

@) Mueva regidn [hregidn

Old and Mew Yalues. .. |

] I Eastel Eesetl Ear‘n::ell Help |

= Clic en valores antiguos y nuevos. (Old and New Values)

» En la seccién Valor antiguo (Old Value) marcar el circulo al lado de Rango
(Range) (ubicada en la parte central lado izquierdo) y en la celdilla al lado de “Del
menor hasta” (Lowest through) escribir: 20. En la seccion Valor nuevo (New
value) escribir en Value:1 y elegir el boton afiadir (Add). Aparece: Lowest thru 20

->1

Recode into Different ¥ariables: Old and New Yalues

— 0ld Walue e Walue

™ Yalue: I

" System-mizzing

|Vﬁ' W alue: |1| " System-missing

" Copy old value(s)

£ Spstem- or Wser-mizsing

0ld --» Mew:

" Range;

I {1 i I
¥ Fange:
Loweszt through IED—
" Range;
I— bhragty brakest

Al ather values

Add |
[Efiatne |

EEmase

Continue |

[~ Dutput warables are stings it IE

™ | Eotrverh rument sthings b rumbens s

Cancel Help |
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= Marcar el circulo al lado de Rango (Range) (ubicada encima de la anterior) y en
la celdilla a la izquierda de “hasta” (through) escribir: 20 y en la de la derecha
escribir: 25, en Valor nuevo escribir en Value: 2 y pulsar el boton afadir (Add).
(Se recodificaran como 2 los valores de edad mayores que 20 y menores o

iguales a 25.) Aparece: 20 thru 25 > 2

— 0ld VY alue Mew Walue
W alue; I oy "»-"a_lue:l:{ " Spstem-mizzsing
" Supstem-missing " Copy old value(s]
" System- or user-missing Qld = Hew:
' Range: Add Loweest thru 20 -3 1
|25 thraugh ISIZI = 20 thru 26 -3 2
[Ehatae |
i~ Range:
Lozt thrauat I ﬂl
" Range: [ Dutput variables are stings w/idi Ig
I trauatyhibhest 7| Eariverh numeric sthings b numbers [5G
" Al gther values Cantinue | Cancel | Help |

= Marcar el circulo al lado de Rango (Range) (ubicada encima de la anterior) y en
la celdilla a la izquierda de “hasta” (through) escribir: 25 y en la de la derecha
escribir: 30, en Valor nuevo escribir en Value: 3 y pulsar el botén afiadir (Add).
(Se recodificaran como 3 los valores de edad mayores que 25 y menores o
iguales a 30.) Aparece: 25 thru 30 - 3

= Elegir el circulo al lado de Rango (Range) (ubicada al final de los anteriores) y en
la celdilla a la izquierda de “hasta el mayor” (Through Highest) escribir: 30, en
Valor nuevo(New Value) escribir en Value: 4 y elegir el boton afiadir (Add).
Aparece: 30 thru Highest - 4

Recode into Different Yariables: Old and Hew Yalues x
— Old Y alue Mew YWalue
& Walue: I 4 alue: |4 " System-missing
" Spstem-miszing " Copy old value(s]
" Spstem- or Wser-mizsing 0ld -» Mew:
" Range; Add Lowest thru 20 - 1
— 20 thry 25 - 2
! it | Cherge | 25 thru 30 -> 3
™ Range:
[Lawest thramgt I GHETEE |
& Range: [ Output varables are stings it IB
|3':' thraugh highest ™ | Eativerh rument sthings b numbens s
Al gther values Continue | Cancel | Help |

» Pulsar el boton Continuar (Continue) y después el boton Aceptar (OK).
» Editar la variable NEDAD. Los datos deben estar sin decimales. Las etiquetas
(Labels) deben ser: Value:1; Value Label:Del menor a 20; 2:De 20 a 25; 3:De 25
a 30y 4:De 30 al mayor.
CREACION O TRANSFORMACION DE VARIABLES (COMPUTE)
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Si se elige Transformar - Calcular se pueden crear variables nuevas o transformar las
funciones aritméticas, funciones
estadisticas, funciones logicas y otras (Comando COMPUTE).
Con esta primera opcion dentro del mena Transformar podemos crear nuevas
variables asignando a éstas los valores resultantes de operaciones algebraicas.

ya existentes mediante operadores aritméticos,

3.- A partir de los datos de peso (Kg.) y altura (en cm) de un individuo,

indice de masa corporal de acuerdo a la expresion algebraica:

indice de masa corporal

= peso / (estatura / 100)?.

» Transformar - Calcular. (Transform —Compute)

» Escribir: IMC en el casillero Variable de destino(Target Variable)

» En la casilla Expresion numérica se construye la definicion de esta variable (Se
puede emplear la lista de las variables, los operadores aritméticos, los nUmeros y
las funciones):

» Transferir la variable Peso a la ventana Expresion numérica (Numeric Expresion).
Clic en el operador: /. Luego clic en los paréntesis. Introducir la variable Estatura.
Fuera del paréntesis, clic en ** para elevar a la potencia. Luego clic en el
namero: 2 para elevarlo al cuadrado y clic en OK.

= Editar la variable de ser necesario.

calcular su

d | sexo nombre estatus region ci estatura peso imc

15 2 [ Abigail 1 3| 124 154 578 24 41
6 1| Carlos 1 3 85 154 86.7 239
i1 1| Alberto 1 21 1M 156 528 21.70
24 2 | Adela 2 3| 1B 184 104.2 30.78
[ Conputs varianie — = | I
- Target Y ariable: Murneric Expression: —
3 JmMe - pesa / (estatura / 100] * 2 = 24.74
T Typetlabel.. | _| 3012
20 |4 Mimero de identific < ¢ I 28.07
i | _<d o] 208] 8] Functions: [~ ] T nm
2| senn | <=]>=] 4]5]|&] AB S [numespr) ﬂ S ——
| @numbre _I _=|_| _Iilil AMYtest value, value,..] 28.70
- | Estatus socinecont ARSIN[Pumexpr] —
2@ region s o] R TAN numespn 25 B3
i - ) _I ~| | Delete COFMNORM[zvalue]

) > Cociente intelectua COF.BERNOULLIq.p) =] 95 17
_ | estatura I
2 |® peso s 22,98
- | ime ———
I LI (] 4 I Paste | Beset | Ear‘u:ell Help | 29.30

e Grabar como: File > Save as. Nombre de archivo: MIAPELLIDO
Clic en Guardar.
e Cerrar el archivo MIAPELLIDO.SAV
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) PRACTICA N° 04
CALCULO CON VARIABLES TIPO FECHA

FUNDAMENTO: Para el célculo de la edad en afios de un individuo sabiendo la fecha
actual y su fecha de nacimiento, debemos recurrir a la funcion denominada

CTIME.DAYS(fecha).

Supongamos la fecha actual 15 de marzo del 2003, y la variable f nacim
conteniendo la fecha de nacimiento de los casos. Introduciendo en la ventana de las
expresiones la siguiente:

(CTIME.DAYS(DATE.DMY(03,15,2003))-CTIME.DAYS(f_nacim))/365
Nota: El formato de fecha puede variar.

Como resultado obtendremos los afios transcurridos entre ambas fechas. Si
gueremos un mayor grado de pulcritud podemos dividir entre 365.25 dias para tomar en
cuenta los bisiestos o usar la funcion RND(exp_numeérica) para redondear el resultado
al entero mas proximo.

La funcion DATE.DMY(dia,mes,afio) transforma los argumentos dia, mes y afio
a un dato tipo fecha para poder ser empleado, al igual que f_nacim, como argumento de
la funcion CTIME.DAYS(valorfecha)

1.- Crear el archivo: FECHAS.SAV.

e File > New - Data.
a) Definir las siguientes variables. Doble clic sobre Var. Luego llenar segun Tabla:

Variable FNACIM FINGRESO FALTA
Name

Type Date dd.mm.yyyy| Date dd.mm.yyyy Date dd.mm.yyyy
Variable Fecha de | Fecha de ingreso Fecha de alta

Label nacimiento

b) Ingresar los siguientes 5 registros :

Fnacim Fingreso Falta
1 07.12.1959 10.03.2003 14.03.2003
2 01.04.1956 01.03.2003 14.03.2003
3 01.01.1990 01.01.2002 01.01.2003
4 31.12.1980 31.12.1999 31.12.2002
5 28.02.1990 30.12.1999 05.05.2003

c) Calcular la variable Edad, expresada en afios cumplidos a partir de la fecha actual.

Dr. Antonio Alva Santos aalval959@yahoo.es
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(Ej. Supongamos que la fecha actual es: 15 de marzo del 2003).

EDAD = FECHA ACTUAL (15,03,03) — FECHA DE NACIMIENTO

Es decir, la EDAD se calculara ingresando las variables y fechas:

Transform - Compute

RND((CTIME.DAYS(DATE.DMY(15,03,2003))-CTIME.DAY S(fnacim))/365)

Resultados:
fnacim fingreso falta edad var va
1 07.12.1959 10.03.2003 14.03.2003 43
2 01.04.1956 01.03.2003 14.03.2003 47
3 01.07.1930 01.01.2002 01.01.2003 13
4 31121980 31121999 31.12.2002 22
] 28.02.1990 30.12.1999 05.05.2003 13
BRI Corputo variabie
—1— Target Yanable: Mumeric Expression:
i IED.-’-‘-.D = RMD[[CTIME.DaYS(DATE.DRY(15.03,2003]] - ;l
- CTIME.D&YS [fracim]] / 365]
i TypetLabel... | J
9 “#»iFecha de nacimisnto || | 14 I
10 [ | & Fecha de ingrezo [fing: LI LILI ilil_al Functians:
| gfa:ad | <=>=] 4]5]8] AR5 [numespr) ﬂ
11 e03 s === 1]z 3| |ANTtest value value,..]
1 _I _I_I _I_I_l ARSIM[numespr]
12 A s Lo ] |aRT AN Rumexpn
1 —r COFMORM[zvalue]
13 = =0l _Delete || Fpr gERNOULLIG p) =
14 IE.. |
ﬁ__ (] 4 I Eastel Eesetl Eancell Help |
4
d) CALCULA LAS NUEVAS VARIABLES:
» SEGUNDOS = Los segundos permanecidos en condicibn de internados

comprendidos entre la fecha de ingreso y la fecha de alta.

DIAS = Los dias comprendidos entre la fecha de ingreso y la fecha de alta.
DIAS1 = Los dias internados incluyendo el dia de ingreso.

ANOS = Los afios permanecidos internados.
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Resultados:
fnacim Fingreso Falta SEGUNDOS| DIAS |DIAS1| ANOS

1 | 07.12.1959 [10.03.2003| 14.03.2003 345600 4 5 0
2 | 01.04.1956 |01.03.2003| 14.03.2003 | 1123200 13 14 0
3 | 01.01.1990 |01.01.2002| 01.01.2003 | 31536000 | 365 | 366 1
4 | 31.12.1980 |31.12.1999| 31.12.2002 | 94694400 | 1096 | 1097 3
5 | 28.02.1990 [30.12.1999| 05.05.2003 | 1.06+08 | 1222 | 1223 3
Solucion:

SEGUNDOS = falta — fingreso

DIAS = CTIME.DAYS(falta) — CTIME.DAYS (fingreso)

DIAS1 = (CTIME.DAYS(falta) — CTIME.DAYS (fingreso) + 1

ANOS = RND((CTIME.DAYS(falta) — CTIME.DAYS (fingreso)) / 365)

OTRA FORMA DE CALCULO: Utilizando comandos en la ventana de sintaxis
e (FILE - Data = Syntaxis). Escribir:

COMPUTE SEGUNDOS = falta - fingreso .
EXECUTE .

COMPUTE DIAS = CTIME.DAYS(falta) - CTIME.DAYS(fingreso) .
EXECUTE .

COMPUTE DIAS1 = RND(CTIME.DAYS(falta) - CTIME.DAYS(fingreso)) + 1 .
EXECUTE .

COMPUTE ANOS = RND((CTIME.DAYS(falta) - CTIME.DAYS(fingreso)) / 365) .
EXECUTE .
e Guardar como: File=> Save as. Escribir nombre del archivo: Fechas

e Clic en Guardar.
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PRACTICA N° 05
CREACION O TRANSFORMACION CONDICIONAL
DE VARIABLES (IF)

File = Open. Abrir el archivo: MIAPELLIDO.SAV
1.- Se quiere hallar la variable IMC que tiene la férmula peso/(estatura/100)**3 pero
sOlo para las mujeres que midan mas de 1.60 m. El proceso es:
» Elegir Transformar - Calcular (Transform—Compute). Clic en Reset.
= Escribir el nombre de la nueva variable: IMC en la celdilla debajo de Variable de
destino (Target Variable).
= Escribir la expresion peso/(estatura/100)**3 en la celdilla debajo de Expresion
numeérica.
» Peso; /; (); estatura; /; 100; **; 3

+ Compute ¥arnable

T arget ' ariable; Mumeric E xpression:
Im = peso / [estatura / 7100] EI
Typetlabel... |
@ Nimero de idertific [ L I
@ edad sl <l>| 78] 3] Functons: [ =]
%SE”D _I i= ﬁl ilil_al SRS [numespr]
Ay norbre | = ~=| ] 2] 2| |ANYtest value value,..]
< Estatus socioecont _I _I_I _I_I_l ARSIN[numex=pr]

& regid Ao Lo ] |aRT AN Rumespr)
reaen ] = ()| el | |COTNORMvalue)
& Cociente intelachua EEE | |COF.BERMOULLIq.p]

kak
o N
i
;I Q. I Eastel Eesetl Eancell Help |

» Haga clic en el boton IF (Si)... y aparece el Cuadro “Calcular variable: Si los
casos” Compute variables: If Cases).

* En este cuadro marcar el circulo al lado de “Incluir si el caso satisface la
condicion” (“Include if case satisfies condition”).

= Escribir en la casilla la expresion sexo = 2 & estatura > 160 o ayudandose de los
elementos del cuadro de dialogo.
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Compute Yarniable: If Cazes

™ Include all caszes

< Mumero de identificaci
@ edad % |nclude jf caze satizfies condition:

# sero sewo = 2 & estatura > 160

E‘, nombre I

< Estatuz socioecondmic

@regién :
< Cociente intelectual [ci ;I LI ililil Eunctions: E

|
%Eslatura _I = ﬁl ililil ABS[nurmexpr]
peso Cl (I ANYtest value, value...)
A ime FI == TEE AR SIM[rumexpr)
2 s e | aRTaNmumespn
w| CDFMORM([zvalue]
2 =10 _pelets ||| o sepnOULLIG 0)

Eu:untinuel Cancel | Help |

= Clic en Continuar(Continue) y Aceptar (OK).
» Guardar el archivo como: TRANSFORMACION o pulsar las teclas Control + S si
se quiere grabar las ultimas modificaciones o céalculos realizados.

NOTA: Si la variable IMC ya existe se calculara la expresion para las mujeres de mas
de 160 cm; para el resto de las mujeres y todos los hombres la variable IMC tendra el
valor que tenia antes de hacer la transformacion.

Resultados comparativos:

Resultados del ejercicio No. 3 sobre el calculo del IMC.
Se muestran 10 de los 150 casos.

Sexo estatura peso IMC IMC
Mujer 154 57.9 24.41 24.41
Hombre |154 56.7 23.91 23.91
Hombre |156 52.8 21.70 21.70
Mujer 184 104.2 30.78 16.73
Hombre |173 87.5 29.24 29.24
Mujer 170 71.5 24.74 14.55
Hombre |176 93.3 30.12 30.12
Hombre |188 99.2 28.07 28.07
Mujer 169 76.6 26.82 15.87
Mujer 175 87.9 28.70 16.40

Utilizando comandos en la ventana de sintaxis (File > New—> Syntaxis)
Escribir:

IF (sexo = 2 & estatura > 160)
IMC = peso / (estatura / 100) ** 3.
EXECUTE .

e Guardar como: File=> Save as. Escribir nombre del archivo: Condiciones
e Clic en Guardar.
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PRACTICA N° 06: SELECCION DE CASOS O GRUPOS

SEGMENTAR ARCHIVOS SELECCION DE CASOS

(SPLIT FILE)

Describe cdmo realizar el|Para realizar el analisis de datos con una parte de
analisis estadisticos para |los sujetos que cumplen una o mas condiciones.

cada grupo de sujetos|Datos—Seleccionar casos

definidos por una variables. |Se pueden seleccionar los hombres que pesan mas

Datos-Segmentar archivos de 80 kg.

30).

Restringir el analisis a un rango de casos (del 5 al

Analizar un porcentaje aleatorio de sujetos.
Analizar desde los sujetos del 1 al n.

e Abrir el archivo: MIAPELIIDO.SAV
SEGMENTAR ARCHIVOS (SPLIT FILE)

1.- Hallar la correlacion de Pearson entre peso y estatura por separado para hombres y

mujeres.

» Clic en Datos—Segmentar archivos. (Data—Split File). Entonces se marca el circulo

al lado de “Comparar los grupos” (“Compare groups”).

» Transferir la variable sexo y clic en OK. En la barra de estado aparecera en la ultima

casilla la Ealabra “seﬁmentado” iSﬁIit File Oni.

@ Momero de identificaci € Analyze all cazes, do not create groups

@ edad ™ Compare groups

(8 nombre & ‘Organize output by groups

& Estatus socioecondmic Groups Based arr

A reqicn Fr—

& Cociente intelectual [ci E

@ estatura

@ pesn

@ ime s
=" Sort the fil= by grouping wariables
™ File is already sorted

Current Statuz: Analysiz by groups is off,

Utilizando comandos en la ventana de sintaxis seria:
SORT CASES BY sexo .
SPLIT FILE

SEPARATE BY sexo .

» Luego se elige Analizar—Correlaciones—Bivariadas
Bivariate) se transfieren las dos variables y clic en OK.

Resultados del analisis:

»

Ok
Baste
Beset
Cancel

Help

iz

(Analyze—Correlate—
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SEXO PESO ESTATURA
Hombre PESO Pearson Correlation 1.000 .595
Sig. (2-tailed) . .000
N 75 75
ESTATURA Pearson Correlation .595 1.000
Sig. (2-tailed) .000 .
N 75 76
Mujer PESO Pearson Correlation 1.000 .594
Sig. (2-tailed) ) .000
N 74 74
ESTATURA Pearson Correlation .594 1.000
Sig. (2-tailed) .000 .
N 74 74

** Correlation is significant at the 0.01 level (2-tailed).

= Si se quiere volver al estado original hay que acceder al cuadro de dialogo
“segmentar archivo” (Data- Split file) y marcar el circulo al lado de “Analizar todos los
casos, no crear grupos” (“Analyze all cases, do not create groups”), y clic en OK.
También puede hacer clic en el boton RESET (Restablecer) y en OK.

|

+ Split File

@ Mirmera de idertificach € Analyze all cases. do not create groups
@ edad ™ Compare groups Paste
&} nombre * iOrganize output by groups —
@ Estatug socinecondnic Groups Based on: Beset
@ regidn @ SERD Cancel |
& Cociente intelectual [ci E
@ estatura Help |
& pesn
@ i _ _ _

& Sort the file by grouping waniables

= File iz already zorted

Current Statuz: Analyziz by groups iz off.

» De la barra de estado desaparecera el mensaje “Segmentado” (Split File On). Y
proceder a realizar otras acciones, caso contrario solamente analizard los datos
filtrados.
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2.- Analizar solo los casos de estatus bajo (valor 3) que no sean del Norte (valores 2,3y

4 de region).

= Clic en Datos — Seleccionar casos (Data—Select cases)
» Marcar el circulo al lado de “Si se satisface la condicion” (“If condition is satisfied”).

i Select Cases x
- e[ S E|ECE
AiNumero de identificaci
@ edad = 4l cazes
@ sewo & |f condition is satisfied
“# Estatus socioecondmic If... |
@ reglu?un ) | ™ Random zample of cases
> Cociente intelectual [ci
Sample.
A estatura _l
& pesn " Bazed on time or case range
@ innc Eanges.. |

™ Use filter variable;

B

— Unzelected Cazes fre
* Filtered

™ Deleted

Current Statuz: Do not filter cases

[f | Easte | Eesetl Eancell Help |

» Pulsar el boton “Si...” (“If..."). Se accede al cuadro de didlogo “Seleccionar casos: si".

(Select Cases: IF)

= Escribir o componer la expresion: region >=2 & estatus = 3. Transferir la variables y
utilizar los operadores necesarios.

Select Cazes: If E
< Nomero de identificaci reqidn »= 2 & estatus = 3 ;I
# edad |
# sew0 =l
[A] nombre _

o Estatus socioecondmic ;I ;I;I ililil Eunctions: E
gsgiént intelectual [c _I i= ﬁl ililil ABS[numespr] ﬂ
acienie Intslectual (ol | = ~= AMYtest, value value,...]
@estatura _I _I_I llil ARSIM[numespr]
@ peso A s ] o ] R TaN mumespd
. —r COFMORM[zvalue]
# ime 2 =10f _belete | pF BERNOULLIGp) =l
Cantinue | Cancel | Help

= Clic en Continue
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i Select Cases X
—— [ Select
& Numero de identificac
B edad Al cazes
@ sexo & |f condition is zatisfied
& Estatus socioecondmic | Hregidn»= 2 hestatus =3 .
® rEg'F'n ] | " Random sample of cases
> Cociente intelectual [ci
Sarmple... |
@ exztatura
@ peso ™ Bazed on time or case range

Hr imc Hatige.. |

= Use filker variable;

]

i+ Filtered

— Unzelected Cazes Are

" Deleted

Current Status: Do not filter cazes

k. | Pazte | Eesetl Eancell Help |

» Clic en OK. En la barra de estado aparecera el mensaje “filtrado” (Filter On).

= A partir de este momento sélo se procesaran los casos que cumplan la condicion.

= QObserve en el editor de datos co6mo se marcan los casos no seleccionados.

» En la ventana editor de datos, en la ultima columna se crea la variable filter_$ que
tiene valor 1 si se cumple la condicion (region sea mayor que 2 y el estatus 3), y

tiene valor O en el resto de los casos.

» Clic en el icono Value labels (Etiquetas de los valores) de la barra de herramientas.

= Observara que 1 equivale a caso seleccionado (Select) y los casos con valores
perdidos o que no cumplen la condicion (Valor 2) equivale a Not Select (No

seleccionado).

Dr. Antonio Alva Santos aalval959@yahoo.es

Pag. 22 de 70



Guia de SPSS Facultad de Ingenieria

/15/ 16 29 | Mujer | Alana Alto Marte | B5 156 539 2215 | Mot Selecte
17 17 29 | Homb | Jose Bajo Sur | 147 172 786 26.87 Selected
/13/ 18 16 | Mujer | Albertina Alto Marte | 113 175 857 15.99 | Mot Selecte
/I{ 19 31 | Homb | Armando Alta Oeste | 99 168 a4 26.71 | Mot Selecte
/zﬂ/ 20 18 | Homb | Constante tedin Sur | 117 1589 730 28.88 | Mot Selecte
/I( 21 21 | Homb | Taribia Alta Este | 105 178 G768 27.65 | Mot Selecte
/22/ 22 29 | Homb | Borja Alto Este | 92 174 742 2451 | Mot Selecte
23 23 23 | Mujer | Alejandra Bajo Sur| 78 178 100.8 17.89 Selected
/2( 24 28 | Mujer | Alicia Alta Sur| 97 163 77 17.80 | Mot Selecte
23 24 19 | Homb | Manuel Bajo Sur| TV 180 746 23.02 Selected
26 26 31 | Homb | Carlos Bajo Sur| & 174 702 2319 Selected

Si se quiere volver a analizar todos los casos:

Data—Select cases:

= Marcar el circulo al lado de “Todos los casos” ( “All cases).

» Luego clic en OK (Aceptar).

» Observe que debe desaparecer el mensaje de datos filtrados (Filter On) de la barra

de estado de la pantalla.

i Select Cases x

AbiNUmern de identificaci
A edad

> zewo

@ Estatus socinecondnic
> region

& Cociente intelectual [ci
@ estatura

& pesn

e

—Select

= 4l cazes
% |f condition iz satisfied

™ Random zample of cazes

Sample...

H

{~ Bazed on time o case range

Eratme...

i

= Usze filker variable;

&

— Unzelected Cazes fre

i+ Filtered "~ Deleted

Current Statuz: Do not filter cases

] | Easte | Eesetl Eancell Help |

e Guardar como: File=> Save as. Nombre del archivo: Casos-Grupos.

e Clic en Guardar.
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PRACTICA N° 07: DESCRIPCION Y MANIPULACION BASICA

» Listado méas simple de los casos: El listado de los valores en las variables
1.- Producir un listado de las variables: iden, nombre, peso, estatura y estatus para los
10 primeros casos de la muestra de datos del archivo de la practica N° 04.

o Clic en el Menu: Analyze ---- Reports --- Case summaries
(Analizar —Informes — Resumenes de casos.)

0 Se seleccionan y transfieren a la seccién “Variables” las variables: iden
(nimero de identificacién), nombre, peso, estatura y estatus (estatus
socioecondmico).

o En la casillero, al lado de Limit cases to list (limitar los casos a los primeros)
escriba: 10. Por ultimo clic en el boton OK para aceptar.

' Summarize Cazes

!

> regicn = 2 & estatus = > Estatus socinecondmic Cancel

@ edad "Wariables:
> sewo 4 Nimero de identificacis

> regidn (AL nambre Faste |
& Cociente intelectual [c] # peso Reset |
A ime A estatura

Help

Grouping Y aniable(z):

—

v Dizplay cazes
¥ Limit cazes ta first |10
¥ Show only walid cazes

[T Show case numbers Statistics. . | Optichs...

Resultados: (Tabla editada)
Case Summaries®

Numero de | NOMBRE | PESO |ESTATUR Estatus
identificacion A socioecondmico
del sujeto
1 1 Abigail 57.9 154 Alto
2 2 Carlos 56.7 154 Alto
3 3 Alberto 52.8 156 Alto
4 4 Adela 104.2 184 Medio
5 5 Luis 87.5 173 Alto
6 6 Adelina 71.5 170 Medio
7 7 Antonio 93.3 176 Alto
8 8 Juan 99.2 188 Alto
9 9 Adriana 76.6 169 Medio
10 10 Agata 87.9 175 Medio
Total | N 10 10 10 10 10

a Limited to first 10 cases.
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El listado de casos se puede fraccionar por los valores de variables
(categéricas usualmente)

2.- Listar por separado alos hombres y a las mujeres.

» Para ello en el cuadro de didlogo, hay que seleccionar la variable sexo y trasferirla a
la seccion Grouping variables (Variables de agrupacion).

En el caso de fraccionamiento del listado puede ser relevante describir los
subgrupos (mujeres, hombres) con estadisticos descriptivos: media (mean),
desviacion tipica (Standard Deviation), etc) haciendo clic en el botén Statistics
(Estadisticos) y seleccionado dichos estadisticos. Continue.

Clic en Options (Opciones) cambie el titulo: Case summaries por Resumenes de
casos. Finalmente, si todo esta correcto clic en OK.

* ORDENAR CASOS (SORT)

Se pueden ordenar los datos en orden ascendente (por defecto) o descendente en
funcion de una o mas variables.

3.- Ordenar los datos por el ci(cociente intelectual).

» Clic en el menu: Data — Sort Cases (Datos — Ordenar casos).

= Seleccionar la variable ci (cociente intelectual) y transferirla a la seccion Sort by
(Ordenar por). Clic en la casilla de ascendente o descendente segin sea
necesario. Finalmente clic en OK para aceptar.

» Observe los datos ordenados en la pantalla para comprobarlo.

* Nota: Se puede ordenar por mas de una variable, situada en el cuadro de
dialogo, se seleccionan y transfieren a la seccién Sort by (Ordenar por). Cada
variable de ordenacion puede ir en orden ascendente o descendente
independientemente. Si después de realizar una ordenacion se guardan los
datos, se mantiene la ordenacion por los criterios elegidos.

IMPORTANTE:

» DESCRIPCION RAPIDA DE VARIABLES

Sdlo disponible con lenguaje de comandos. Empleando el comando DESCRIPTIVES se
puede conseguir una descripcion condensada (media, desviacion tipica, minimo,
maximo y numero de sujetos o cuestionarios aplicados) y rapida de las variables. El
comando es: DESCRIPTIVES ALL.

o Clic en el menu: File — New — Syntaxis
o Escriba:

DESCRIPTIVES ALL.

o Clic en el ment: Run—All (¢ Algun comentario sobre la Tabla?)
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PRACTICA N° 08: DESCRIPCION DE VARIABLES NOMINALES

Las variables nominales se estudian mediante la distribucién de frecuencias, la grafica
de barras o la grafica de sectores y un estadistico descriptivo: la moda. Variables
nominales en el estudio que venimos tomando como ejemplo son el sexo y la region.

1.-

DESCRIBIR LA VARIABLE REGION.

Analyze—Descriptive Statistics —Frequencies (Analizar — Estadisticos descriptivos —
Frecuencias)

Seleccione region y transferirlo a la seccién Variables.

Clic en el boton Chart (Graficos) de este cuadro, marcar la opcion Bar Charts
(Graficos de barras) y hacer clic en botén Continue (Continuar). Alternativamente se
puede marcar la opcion Pie Chart (Grafico de sectores).

Para hallar la moda. Clic en el botdn statistics (Estadisticos) del cuadro de dialogo,
marcar el estadistico Mode (Moda) en la seccion de Central tendency (tendencia
central) y se pulsa el boton Continue (Continuar).

Por ultimo clic en el boton OK para aceptar.

Nota: Puede realizar la descripcion de las dos variables regién y sexo en forma
simultanea si lo prefiere.

Comentarios:

En la Tabla pivote se puede ver que hay 43 personas del Norte que suponen un
28,7 % de la muestra (43 de 150). La diferencia entre porcentaje valido y porcentaje
es que en porcentaje valido no se tiene en cuenta los casos perdidos (no se
contabilizan los casos perdidos), en esta variable existe un caso perdido (valor 9) y
por lo tanto hay 149 sujetos validos; lo que supone un 28,9% (43 de 149). El
porcentaje acumulado va sumando la frecuencia de cada valor con las frecuencias
de los valores menores a él; aunque con variables nominales no tiene mucho
sentido.

En la grafica de barras se observa que la barra de menor altura corresponde a la
categoria SUR con menor niumero de casos. Y que la barra de mayor altura es la del
Norte, que es la que incluye mayor nimero de casos.

Si desea cambiar el aspecto de la gréfica o afiadir nuevos elementos hay que
editarla. Para editar una grafica pulse clic dos veces sobre ella. Por ejemplo, puede
afadir el nimero de casos a cada barra pulsando el icono (Bar Label style) en forma
de dos pequefias barras de color amarillo, ubicada en dicha barra de herramientas.
Clic en estandar y en Apply all.

Trate de cambiar el color delas barras a AZUL y el color blanco para indicar el
namero de casos. El titulo del grafico debe decir: Distribuciéon de casos segun
Region.
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PRACTICA N° 09: DESCRIPCION DE VARIABLES ORDINALES

Las variables ordinales se estudian mediante la distribucién de frecuencias, la grafica

de barras (o la grafica de sectores si hay pocos valores distintos) y los estadisticos

descriptivos: mediana, amplitud (Rango), maximo y minimo. Cuando existen una gran

cantidad de valores distintos (por ejemplo, mas de 10) se analizan como variables de

intervalo. También en el caso de depuracién de items de pruebas y encuestas se

utilizan los indices de asimetria y apuntamiento. Variables ordinal en este estudio es el

estatus.

1.- Describir la variable ordinal estatus socioeconémico

Para describir la mediana, rango, minimo y maximo: Analizar —Estadisticos
Descriptivos — Frecuencias (Analyze — Descriptive Statistics — Frequencies.
Transferir la variable estatus socioecondmico a la seccion Variables.

Luego clic en statistics. Marcar solamente la mediana (median) para la tendencia
central (Central tendency) y, en dispersidbn, marcar: rango (range), minimo
(minimum) y maximo (maximun). Clic en Continue.

Para graficar clic en Chart y activar Pie Chart y en continue. Clic en OK.

Editar el gréfico: Clic en el elemento titulo debe decir: Estatus socioecondmico
gréfico de sectores. Para que se tenga los valores y porcentajes en cada tipo de
region. Clic en el nombre de cualquier regién y activar las casillas Value (Valor) y

Percents (Porcentajes).

Estatus socioeconémico

Frequency] Percent] Valid Cumulative)
Percent Percent
Valid Alto 76 50.7 514 51.4
Medio 41 27.3 27.7 79.1
Bajo 31 20.7 20.9 100.0
Total 148 98.7 100.0
Missing 9 2 1.3
Total 150 100.0

Comentario:
De estatus alto hay 76 casos. Son el 50,7% de todos los casos (76 / 150). Y suponen
un porcentaje valido del 51,4% (76 /148).
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PRACTICA N° 10: DESCRIPCION DE VARIABLES DE INTERVALO

Las variables de intervalo se estudian mediante el histograma, y los estadisticos descriptivos: media
(mean), desviacion tipica (Standard Deviation), range (range), maximo (maximum) y minimo (minimum), y
los coeficientes de asimetria y apuntamiento. No conviene obtener la distribucién de frecuencias porque
al tener usualmente un gran numero de valores distintos la variable de intervalo, resulta demasiado
extensa la distribucion. Para ello elimine la marca de la opcién “Mostrar tabla de frecuencias” (“Display
frequency tables”) en el cuadro de didlogo de Frecuencias (Frequencies). Variables de intervalo o razén
en este estudio son: la edad, el peso, la estatura y el ci (cociente intelectual).

1.- Describir las variables edad, peso, estatura y ci

= Elegir Analizar-Estadisticos Descriptivos—Frecuencias (Analyze-Descriptives Statistics-Frequencies).
Seleccionar y transferir las variables. Desmarcar la casilla de “Mostrar la tabla de frecuencias”
(Display frequency tables).

= Pulsar el botén graficos (Charts) y marcar Histogramas y la opcién “Con curva normal” para que
sobreimprima la curva de la distribucién normal. Pulsar el botén Continue.

= Pulsar el boton Estadisticos (Statistics) y marcar la media, la desviacién standard, el rango, el minimo
y el maximo. La simetria y la curtosis o apuntamiento. Autométicamente se hallan también los errores
tipicos de la simetria (S.E. Skew) y del apuntamiento (S.E. Kurt). Para obtener el error tipico de la
media marcar “E.T. media”. Clic en continue y en OK.

Statistics
EDAD PESO| ESTATURA Cociente
intelectual
N Valid 148 149 150 149
Missing 2 1 0 1
Mean 24.25 76.774 168.85| 101.658
Std. Error .46 1.004 1.12 1.857
of Mean|
Std. 5.60 12.255 13.73 22.672
Deviation
Skewness .169 -.030 2.505 .100
Std. Error .199 .199 .198 .199
off
Skewness
Kurtosis| -1.076 -.658 18.934 -.410
Std. Error .396 .395 .394 .395
of Kurtosis
Range 20 53.8 139 107.0
Minimum 15 50.4 131 52.0
Maximum 35 104.2 270 159.0

Comentarios:

La media del ci es 101,6, la desviacion tipica 22,6, el coeficiente de apuntamiento (curtosis) vale —0,41
(menos apuntada que la distribucion normal), el coeficiente de asimetria es 0,1 (ligeramente asimétrica
positiva), el valor minimo es 52 yy el maximo 159, el rango de 107. Hay 149 casos validos y 1 caso
perdido. De estos estadisticos el que puede, de entrada, ofrecer menos informacién es la desviacion
tipica (medida de dispersion). Sin embargo, si se recuerda una de las propiedades de la distribucién
normal: que el 95% se encuentra entre dos desviaciones tipicas a cada lado de la media, se obtiene una
idea mejor de la dispersidn del grupo: el95% de los casos estara entre 101,6 +- 45,3. La desviacion tipica
da una informacién mas intuitiva cuando se comparan las dispersiones de varios grupos.

Para construir el Histograma, el programa agrupa las puntuaciones en intervalo, el punto medio del
intervalo es su valor representativo. La anchura del intervalo, en esta gréafica, es de 5 puntos y el valor
debajo de cada rectangulo del histograma es el punto medio del intervalo dado (s6lo se imprimen los
puntos medios de intervalos alternos).
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PRACTICA N° 11: DESCRIPCION DE VARIABLES POR GRUPOS

(MEANS)
Esta accién se emplea para describir variables cuantitativas en funcién de una o mas
variables cualitativas (categoricas).
1.- Describir las variable ci (cociente intelectual), en funcién del estatus.

» Analizar—Comparar medias—Medias (Analyze-Compare means-Means).

» En el cuadro de didlogo Means hay que transferir la variable ci (cociente
intelectual) a “Dependientes” (Dependent List) y después transfiera la variable
estatus socioeconomico a la ventana Independientes (Independent List) y se
pulsa el boton OK.

‘

@ Nimern de identificaci Dependent List:
A edad & Cociente intelectual [ci

> sewn Paste
@ reqian Beset
@ estatura

& peso Freyiaus I Laver 1 of 1 Mext |

Independent List;

Help

iE status socioecondmic

]

Pl

Optiong...

= Resultados:
Cociente intelectual

Estatus Mean N Std.
socioecondmico Deviation
Alto| 101.645 76 20.433
Medio| 100.500 40 23.822
Bajo| 101.774 31 26.823
Total 101.361 147 22.675

Comentario:

Se ofrece para cada grupo de estatus la media, desviacion tipica y el nUmero de casos.
Se ofrecen estos estadisticos, también para la muestra total. El ci medio de los de
estatus alto es 101,64. Las desviaciones tipicas son muy similares.

= Nota: con el botéon opciones (Options) se pueden hallar otros estadisticos
ademas de la media, desviacion tipica y numero de sujetos, que son los que se
hallan por defecto, y, también realizar un andlisis de varianza y la prueba de
linealidad.
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Means: Options Ed I—

Statiztics: Cell Statiztics:

tdedian s tean

Grouped Median T Mumber of Cazes
Std. Errar of Mean Standard Deviation
Sum
kirirmim
b @i
Range

First

Last

Y ariance

F.urtosziz

Std. Error of Kurtogiz —
Skewness

Std. Error of Skewne
Harmonic M ean il

Statiztics for First Laper
[T Anovatable and eta
[T Test for linearity

ci estatur

*

Ok
Paste
Fezet
Cancel

Help

Ophans...

Folslakelels

x|

Continue I Cancel Help |

DESCRIPCION JERARQUIZADA: Se puede describir la variable cuantitativa en funciéon
de varias variables de clasificacion de una manera jerarquizada.
2.- Diferenciar por grupos de sexo dentro de los grupos de estatus.
» Para ello, en el cuadro de didlogo anterior, hay que pulsar el botdn central siguiente:
Layer 1 of 1 (Next), transferir la variable sexo a “Independientes” (Independent list)

de Layer 2 of 2. Pulsar el boton OK.

& Numero de identificaci Dependent List: 0K
“# edad > Cociente intelectual [ci

. Past
A reqicn Paste
> estatura Reset
& peso

Presios |La_l,ler 2of2 Mext |

Independent List;

A semn
= |

Aparecen los resultados mostrados en la siguiente Tabla:

G

Cancel

Help

Options...
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Cociente intelectual

Estatus SEXO Mean N [Std. Deviation -
socioecondmico Las mujeres de
Alto Hombre 100.098 41 18.116 estatus alto tienen
Mujer| 103.457 35 22.991 un ci medio de
Total 101.645 76 20.433 10345 vy uma
Mediog Hombre 99.235 17 24.692 Py -
Mujer| 101.435 23 23.674 desviacion tipica
Total 100.500| 40 23.822 de 22,9.
Bajo Hombre 99.063 16 29.188
Mujer| 104.667 15 24.729
Total 101.774 31 26.823
Total Hombre 99.676 74 22.108
Mujer 103.068 73 23.264
Total 101.361 147 22.675

= DESCRIPCION DE MAS DE UNA VARIABLE: Si se desean describir por grupos
varias variables cuantitativas éstas se seleccionan y se transfieren a la ventana
“Dependientes” (Dependent list).

GRAFICAS
SIMPLES: Otra manera de describir es realizar graficas de los estadisticos de los
subgrupos.
3.- Hallar una gréafica con las medias en ci (cociente intelectual) de los tres grupos
de estatus).
» Gréficos-Lineas (Graphs — Line). Tipo: Simple. Summaries for groups cases. Clic en

Define.

Line Charts Ed

§| Simple
Cancel |
(}@{ kuiltiple Help |

EEE; Drop-line

—Data in Chart Are

% Summaries for groups of cases
" Summaries of separate variables

™ Walues of individual cases

= En la ventana o cuadro de dialogo siguiente: Clic en la casilla Other summary
function.

= Transferir ci (cociente intelectual) al recuadro de la opcién “Variable” y Estatus
socioecondmico al recuadro “Category Axis” (Eje de categorias). Pulse en OK y
observe que tipo de gréfico obtiene.
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Line: Summaries for Groups of Cazes

— Line Reprezents

& edad
> senn
(AL namnbre
& reqidn
@ eztatura
& peso

& Mimern de identificacis

= M of cazes
= Cum. nof cazes

%' Other summary function

W ariable:

I@ MEAM[Cociente intelectual

[Eharge Sumnmar..

Category fuis:

| 4> Estatus socioecondmic

Template

[ Use chart specifications from;

k.
Pazte
Rezet

Cancel

izl

Help

Titles... |

* Repita los pasos anteriores. Pero antes de pulsar lel boton OK. Haga Clic en el
boton Opciones (Options) y desactive la casilla de “display groups defined by
missing values” (Mostrar grupos definidos por valores perdidos o datos en blanco)
para no incluirlos en el andlisis de los datos.

Mizzing Y alues
%) Erclide cases [istiiee

) Erclide cases vanable by vanatle

e

izplay groups defined by miszing values

» Clic en Continue y en OK. Obtendra el grafico:

Continue

Cancel

Help

dd

102.0

101.84

101.61

101.4+4

101.2+

101.09

100.8+4

100.64

Mean Cociente intelectual

100.4

Al

to Medio

Estatus socioecondémico

Bajo
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GRAFICAS DE DOBLE CLASIFICACION (MULTIPLES)

4.- Obtener una grafica de lineas (multiple) de las medias de ci por grupos de
estatus y separadas por sexo.
» Gréficos-Lineas (Graphs — Line). Tipo de Line Charts: Multiple. Debe estar

seleccionado summaries for groups cases. Clic en Define.

Line Charts E3

T Hiefine

N
Cancel |
|b@< kd Liltiple Hel
o |

ZEEE Drop-line

Simple

[rata in Chart Are

% Summaries for groups of cazes
= Summaries of separate vanables

™ Walues of individual cazes

= Luego. Clic en la casilla Other summary function.
= Transferir ci (cociente intelectual) al recuadro: Variable y Estatus socioeconémico al
recuadro: Category Axis (eje de categoria). Luego la variable sexo hacia: Defined

Lines by (Definir lineas por).

i Define Multiple Line: Summaries for Groups of Cazes

> — Linez Reprezent
Momero de identificacic k. |
@ edad M of cazes % of cazes
= Cum. nof cazes ™ Cum, % of cases Baste

(AL nombre
@; regidn &+ Other summany function Resat |
@) estatura W ariable:
&> peso | % ME&N(Cociente intelect Laies] |

[Eharge Summmar.. | Help |

Categony Sz
I@ Estatus socioecondm

Drefine Iiines b

E I@ SEHO

Template

[ LUse chart specifications from;

g
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= (JO: No olvidar hacer Clic en Opciones (Options) y desactivar la casilla de “display

groups defined by missing values” para no incluir los datos definidos como valor

perdidos o datos en blanco. Clic en Continue y en OK.

Mizzing Y alues
% Eeclide cazes [iEhwise

€0 Erclude caszes vanable by varable

Continue

Cancel

| I Display groups defined by mizsing valuss

= Editar el grafico: doble clic sobre el gréafico.

Help

4

» Clic sobre cada una de las lineas y cambiarlas a color negro.

» Para el caso de la variable sexo (Mujeres): Modificar el estilo de linea (Line style).

Mean Cociente intelectual

105

104 4

103 9 ~

102 1 ~ 7

101 4

99 «

98

100 +
\ SEXO

Alto Medio

Estatus socioeconémico
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GRAFICAS DE DOBLE CLASIFICACION CON BARRAS
Tanto en el caso de una variable de clasificacion como en el de doble clasificacion se

pueden realizar graficas con barras en vez de lineas.
5.- Obtener la gréfica de barras de las medias de ci por cada estatus y separado
por sexos. Editar el grafico.

» Graficos-Lineas (Graphs — Bar). Tipo de Bar Charts: Clustered (Agrupadas). Debe

estar seleccionado summaries for groups cases. Clic en Define.
Bar Chartz

| X
Cancel |
__Heb_|

Help

[rata in Chart Are

% Summaries for groups of cazes
™ Summaries of separate vanables

™ Walues of individual cazes

» Luego. Clic en la casilla Other summary function.
» Transferir ci (cociente intelectual) al reecuadro: Variable y Estatus socioecondmico al
eje de categorias (Category Axis). Luego la variable sexo a Defined Clustered by

(Definir agrupacion por).

+ Define Multiple Line: Summaries for Groups of Cases

— Lines Represent

% :;:jem de identificacic £ H of cases % of cases
[A] nombre " Cum. nof cases ¢ Cum. % of cazes ﬂl
& regidn &% Other summary function Reset |

estatura W ariable:
% pes0 I@ MEAM[Cociente intelect Cancel |
[Eharnge Sumnman.. | Help |

Categaory fuis:
I@ Estatus socioecondm

Define Iiines by:

[ ser

Template

Titlez
[ Use chart specifications from:

Fie | Dptions

il
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= Clic en Opciones (Options) y desactive la casilla de “display groups defined by
missing values” para no incluir los datos definidos como valor perdidos. Clic en
Continue y en OK.

= Editar el grafico: Color de relleno: blanco. Con framed (marcos con los valores)

= Para el color: Seleccionar la barra correspondiente. Clic en icono:Color. Fill:
Seleccionar el color blanco. Apply (Aplicar). Proceder con la barra que corresponda.
Para finalizar haga Clic en Close (cerrar ventanita).

» Para el framed (Marco con valores). Clic en el icono: Bar Label Style. Seleccionar:
framed. Clic en Apply All. Clic en close (cerrar ventanita).

» Pararelleno de cada barra: Seleccionar la barra correspondiente. Clic en el icono Fill
pattern (patrén de relleno). Seleccionar el relleno correspondiente. Clic en Apply.
Proceder igual con la otra barra. Al concluir, clic en close (cerrar ventanita)

» Cerrar la ventana de edicion de gréfico.

105

105
104 » ;’::
g
4
103 « 103 ,:;ﬁ
ey o
g
102 » ﬁj
M s
ea 101 ;j::
101 J
n fﬁ
C o -
oc 104 5 s Y
ie 4 | SEXO
nt =y
e 99 ey "'fé |:|Hombre
|nt 08 __,.-"ﬁ - Mujer
Alto Medio Bajo

Estatus
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PRACTICA N° 12: RELACION ENTRE VARIABLES

Los indices estadisticos adecuados para el estudio de la relacion entre variables dependen del
nivel de medida de las variables. Estos indices indican la magnitud de la relacion. Existen
pruebas estadisticas asociadas para comprobar si la relacion es significativa.

Con variables nominales se emplean, por ejemplo los estadisticos chi cuadrado (x?) o el
coeficiente de contingencia (Crosstabs).

Con variables de intervalo se emplea el coeficiente de correlacion de Pearson.

Con variables ordinales se puede emplear el coeficiente ro de Spearman o la tau de Kendall.

. TABLAS DE CONTINGENCIA: RELACION ENTRE VARIABLES NOMINALES
(CROOSTABYS)

Se emplea para hallar simultaneamente distribuciones de frecuencias de dos variables y para

hallar indices estadisticos que midan la fuerza de la asociacion entre las variables.

En el estudio de ejemplo existen dos variables nominales: sexo y regién y una variable ordinal:

estatus socioecondémico, que para todos los efectos se va a emplear en los ejemplos como

nominal.

1.- Estudiar la relacién entre las variables sexo y estatus.

= Para hallar la distribucién de frecuencias cruzadas (tabla de contingencia) del sexo y el
estatus elegir Analizar-Estadisticos Descriptivos-Tablas de contingencia (Analyze-
Descriptive Statistics-Crosstabs), y en el cuadro de dialogo:

= Seleccionar la variable sexo y transferirla a la seccion “filas” (Rows)

= Seleccionar la variable estatus y transferirla a “Columnas” (Columns)

i Crozstabs

!

" — B owal=]: K
@ Mimera de identificach @ senn

@ edad - Paste
(A nombre - —
> regicn Heset

@E ente intelectual [o Colurn[z]:
ociente intelectual [ci - -
<#» Estatug socinecondmic Cancel
& estatura E
& peso Help
F'rexi':'u3| Layer 1 of 1 it =i

iz el

B

[ Display clustered bar charts

™ Suppress tables

Exact... |

Cellz... Format...

= Pulsar el botdn “Estadisticos” (Statistics)
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Marcar los estadisticos Chi cuadrado (Chi-square), coeficiente de contingencia (Contingency
coefficient), Phi y V de Cramer (Phi and Cramer’s V) y Lambda (Lambda). Pulsar el boton

continuar (Continue) y Aceptar (OK).

Crozstabs: Statistics Ed

[ Comelations

V¥ | Chi-zquare

— Maominal
IV Cartingency coeflicient

™ Uncertainty cosflicient

— Ordinal
[T Gamma

[T Somers'd
[T Kendall's tau-b

[T Kendall's tau-c

— Morminal by Interal

[ Eta

[T Cochian's and bantel-H aenszel statistics

([esheanmmet onds ratio) equals: |1

Resultados:

Tabla de contingencia SEXO * Estatus socioeconémico

™ Kappa
I Risk

™ McMemar

Continue

Cancel

d

Help

Estatus socioeconémico

Total

Alto Medio Bajo
SEXQO| Hombre 41 17 16 74
Mujer 35 24 15 74
Total 76 41 31 148

En la tabla de Chi-cuadrado la pregunta que se plantea es: ¢ existe relacion entre el estatus y el sexo?. El
contraste de chi cuadrado de Pearson comprueba si existe independencia o no entre ambas variables.
X?(2)=1,701 p<0,427 indica que no existe relacién entre ambas variables (probabilidad mayor que 0,05,
es decir, no hay asociacioén sistematica de determinados valores de estatus con determinados valores de

SexXo.

Pruebas de Chi-cuadrado

Value df Asymp. Sig. (2-sided)
Pearson Chi-Square 1,701 2 A27
Likelihood Ratio 1,707 2 426
Linear-by-Linear Association ,266 1 ,606
N of Valid Cases 148

a 0 cells (.0%) have expected count less than 5. The minimum expected count is 15.50.
a. 0 Casillas (,0%) tienen una frecuencia esperada inferior a 5.
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La frecuencia minima esperada es 15,50.
Medidas Simétricas (Symmetric Measures)

Value Approx. Sig.
Nominal by Phi ,107 A27
Nominal Cramer's V ,107 427
Contingency , 107 427
Coefficient
N of Valid Cases 148

a Not assuming the null hypothesis. (No asumiendo la hip6tesis nula)
b Using the asymptotic standard error assuming the null hypothesis.
(Empleando el error asintotico basado en la hipétesis nula)

Tabla editada para mostrar sélo los estadisticos Lambda:
Directional Measures (Medidas direccionales)
Nominal por nominal Lambda

Value|Asymp. Std. Error Approx. T|  Approx. Sig.
Symmetric] .048 .043 1.098 272
SEXO Dependent] .095 .082 1.098 272
Estatus .000 .000
socioecondémico
Dependent]

a Not assuming the null hypothesis. (No asumiendo la hipétesis nula)
b Using the asymptotic standard error assuming the null hypothesis.
(Empleando el error tipico asintético basado en la hipétesis nula)
¢ Cannot be computed because the asymptotic standard error equals zero.
No se puede efectuar el calculo porque el error tipico asintético es igual a cero.

GRAFICA DE LA RELACION

Se puede obtener una gréfica de barras si en el cuadro de dialogo de Tablas de
contingencia se marca el casillero “Mostrar los gréficos de barras agrupadas” (Display
clustered bar charts”).

i Owsstabs |

Rowlz):
& Numero de identificaci @ [SE]:-:I:I .
@ edad “ Paste
(A nombre -
< regicn Heset

LColurmn(z]:

Cociente intelectual [ci - -
@ [ > Estatus socioecondmic Cancel

> estatura
@ peso E Help
F'TEEiC'U3|La_I,Ier1 af 1 il s

izl

g

¥ Display clustered bar charts

[ Suppress tables

Exact... | Statistics. .. Cells... Farmat...
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Al editar la grafica, se obtiene:

50

40 o

30 .
R
E
S Estatus socioecondémica
E 204
N EAlto
T 17 )
o - |:|Med|o

10 |:|Baj0

Hombre MJjer
SEXO

PORCENTAJES POR CELDILLA

La tabla cruzada entre region y estatus se i) ™

puede enriquecer hallando las frecuencias | Courts
relativas por filas, por columnas y por el
total. Cancel |

En el cuadro de didlogo de Tablas de | Eipected Help |
contingencia pulsar el botén “Casillas”

(Cell) y marcar en la seccion Porcentajes | | Feeentages— - FResiduals
(Percentages): Fila (Row), Columna | Row ™ Unstandardized
(Column) y Total (Total). Clic en continue y | ¥ Column I™ Standardized
luego en OK. ¥ Total [ Ad standardized

Tabla de contingencia SEXO * Estatus Socioeconémico

Estatus socioeconémico
Alto Medio Bajo
Total
SEXO Hombre Recuento 41 17 16 74
% de SEXO 55.4% 23.0% 21.6% 100.0%
% de Estatus socioeconémico 53.9% 41.5% 51.6% 50.0%
% del Total 27.7%| 11.5% 10.8% 50.0%)
Mujer Recuento 35 24 15 74
% de SEXO 47.3% 32.4% 20.3% 100.0%
% de Estatus 46.1% 58.5% 48.4% 50.0%)
socioecondémico

% del Total 23.6% 16.2% 10.1% 50.0%)
Total Count 76| 41 31 148,
% de SEXO 51.4%| 27.7% 20.9%) 100.0%
% de Estatus socioecondémico 100.0%| 100.0% 100.0% 100.0%
% del Total 51.4% 27.7% 20.9% 100.0%

Dr. Antonio Alva Santos aalval959@yahoo.es Pag. 40 de 70



Guia de SPSS Facultad de Ingenieria

Més de dos variables de clasificacion

También se puede describir relaciones bivariadas en base a mas variables de

clasificacion, por ejemplo, tablas de la relacion entre el estatus y el sexo para cada

region.

= En el cuadro de didlogo de Tablas de contingencia seleccionar la variable region y
transferirla en la ventana debajo de “Capa 1 de 1" (Layer 1 of 1).

= Desactivar la casilla: Display clustered bar charts.

» Desactivar las opciones de Statistics (estadisticas)

» De la opcién Cell, s6lo debe estar activado la casilla: Observed.

» Clic en Continue y luego en OK.

+ Crosstabs

R i
@ Muomero de identificach giﬂm
@ Edad ¥ Paste
[A! nombre —‘
& Cociente intelectual [ci Column(s]: Reset
Lat = -
% Erae & Estatus socioecondmic Lancel
P Help

F'rexi-:'u3| Layer 1 of 1 Mext
< regidn

d

[T Display clustered bar charts

[ Suppress tables

Exact... | Statiztics. .. Cellz... Format...

Resultados:
Estatus socioeconémico Total
REGION Alto Medio Bajo
Norte SEXO Hombre 17 6 4 27
Mujer| 6 7 3 16
Total 23 13 7 43
Este SEXO Hombre 11 3 3 17
Mujer| 8 7 5 20
Total 19 10 8 37
Oeste SEXO Hombre 10 5 4 19
Mujer 10 9 2 21
Total 20 14 6 40
Sur SEXO Hombre 3 3 5 11
Mujer 11 1 5 17
Total 14 4 10 28
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PRACTICA N° 13: RELACION ENTRE VARIABLES DE INTERVALO O
RAZON, RELACION ENTRE VARIABLES ORDINALES (CORRELATION)

El coeficiente de correlacion r de Pearson es adecuado para medir la magnitud y el
signo de la relacion (lineal) entre dos variables cuantitativas (de intervalo o razén). El
coeficiente r varia entre —1 y 1. La fuerza de la asociacion ( o magnitud de la relacion)
es una funcion directa del valor absoluto del coeficiente r, cuanto mas se acerca a 0
menor es la relacién entre las variables, cuanto mas se acerca a 1 (en valor absoluto)
mayor es la relacién entre las variables. La relacion perfecta se da tanto cuanto el
coeficiente vale 1 como cuando vale —1. Y no existe ninguna relaciéon entre las variables
cuando r es igual a o. El signo de r indica el signo de la relacion, si es positivo indica: a
mayor valor en una variable mayor valor en la otra variable, si es negativo indica: a
mayor valor en una variable menor valor en la otra variable. Una relacion de signo
positivo se da entre el peso y la altura de las personas, en general cuanto mayor la
altura, mayor el peso. Una relacion de signo negativo se da entre el nimero de
cigarrillos fumados y la esperanza de vida, en general cuantos mas cigarrillos se fumen
menos esperanza de vida se tiene.

El coeficiente r se interpreta normalmente como el porcentaje de varianza comudn entre
las dos variables. Asi un coeficiente r=0,6 quiere decir que el 36% de la variabilidad
(varianza) de ambas variables es comun. Este porcentaje se halla elevando al cuadrado
r y multiplicando por cien: 0,62=0,36; 0,36 x 100= 36.

1.- Hallar las relaciones bivariadas entre el peso, la estatura y el ci
Se elige Analizar—Correlaciones—Bivariadas. (Analyze—Correlation—Bivariate).

Seleccionar y transferir cada una de las tres variables y pulsar el boton OK (Aceptar).
Esta premarcada la correlacion de Pearson.

i Bivariate Comrelations

X

Mumero de identificacic Yariables: oK

®

@ edad 4 Cociente intelectual [ci]

> semo > estatura Paste
Beset

@ Estatus socinecondric # peso
< regicn

i

Help

— Comelation Coefficients
v Pearson [ Eendallstaub [ Speaman

— Test of Significance
% Two-tailed ™ One-tailed

i

o : Options...
¥ Flag significant corelations =7
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La tabla de con los coeficientes de correlaciébn de Pearson aparece en la tabla abajo
mostrada.

El coeficiente de correlacidon de Pearson entre peso y ci no es significativo: r=0,001
p<0,998.

El coeficiente entre estatura y ci tampoco es significativo: r=0.081 p<0,325.

El coeficiente de correlacién entre peso y estatura si es significativo: r=0,6 p<0,000.
Para comprobar la significacion del coeficiente se realiza un contraste que sigue ka
distribucién t de Student con n-2 grados de libertad, datos que el SPSS no proporciona;
lo que si ofrece es la probabilidad del estadistico t.

Cociente ESTATURA PESO
intelectual
Cociente intelectual Correlacion de Pearson 1.000 .081 .001
Sig. (bilateral) . .325 .988
N 149 149 148
ESTATURA Correlacién de Pearson .081 1.000 .600
Sig. (bilateral) .325 . .000
N 149 150 149
PESO Correlacién de Pearson .001 .600 1.000
Sig. (bilateral) .988 .000 .
N 148 149 149

** Correlation is significant at the 0.01 level (2-tailed).
(La correlacion es significativa al nivel 0,01(bilateral)

GRAFICA DE LA RELACION BIVARIADA (GRAPH SCATTERPLOT)

Se emplea para obtener una representacion grafica (la nube de puntos) de la relacion
entre dos variables. La nube de puntos consiste en un aglomerado de puntos en el que
cada uno representa las puntuaciones obtenidas en las dos variables por cada caso. Se
llama centroide al punto en el que coinciden las medias de las dos variables.

2.- Hallar larelacion entre peso y estatura.

» Gréficos---Dispersion (Graph—Scatter). Definir. Esta previamente marcada la opcion
“simples”. La opcion “Superpuesto” se emplea para representar varias relaciones
bivariadas en la misma grafica. La opcion “Matricial” para representar mas de una

nube de puntos por separado. Y la opcion 3-D para representar la relacion entre
variables.

S catterplot | x|

ile _ i ]
”:.:1 | Simple F b abric: Cancel |
;_-ﬁ:.:f Dserlay =k a0 Help |

= Seleccionar y transferir la variable peso al eje Y (eje vertical). Seleccionar y transferir
al eje X (eje horizontal) la variable estatura.
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= (JO: No olvidar hacer Clic en Opciones (Options) y desactivar la casilla de “display
groups defined by missing values” para no incluir los datos definidos como valor

perdidos o datos en blanco. Clic en Continue y en OK.

i Simple Scatterplot Ed

Label Cazes b

Nimera de identificaci L Ais: Ok,
®

# edad I@ peszo

@ sev0 Easte
[A! rombre & fis: Reset
& Estatus socioecondmic I@ estatura - I
> regid ElES |
> Cociente intelectual [ci Set Markers by: Help |

— Template

[ Use chart specifications from:

Titles. .. Options...

Resultado (luego de editar la grafica):

110

100 9

90 1

80 1

70 o

60 o

50 o

PESO

40 Rsq = 0.3606
120 140 160 180 200 220 240 260 280

ESTATURA
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Editar la gréafica:

» El botdn titulo se puede emplear para afadir titulos (hasta dos lineas), subtitulo, y
notas al pie (hasta dos lineas) a la gréfica.

= La relacion es claramente rectilinea y r es positivo. Lo que es evidente es la
presencia de algunos casos extremos, como el situado en la parte superior derecha,
el de un sujeto que mide mas de 2,70 m de altura. (Sujeto 31).

» Para identificar el valor del caso extremo: Editar el grafico. Hacer clic en el icono
“Point identification” el cursor cambia de forma, mover el ratbn hasta el sujeto y
hacer clic sobre él, autométicamente se insertard el numero de sujeto a su lado. Si
ahora se sitla en la ventana de datos se comprobara que tiene una estatura de 270
cm.

» Para incluir la recta de regresion: editar la grafica. Clic en el icono Chart Options
(Opciones de gréfico). En la seccion “Ajustar linea” (Fit line) marcar Total.

» Si ademas se desea que figure el valor del coeficiente de correlacion elevado al
cuadrado (R?) hacer clic en el botén “Opciones de ajuste” (Fit Options) y en el
siguiente cuadro de dialogo marcar “Mostrar R-cuadrado en la leyenda” (Display R-
square in legende) en la seccion opciones de la regresion.

[ [mfar] w [ L[5 ||| AL 2 /ZI

x|

Fit Lire

— Dizplay Options

T | Showsubareps W Total [T Subgroups _l

C I
Fit Optionz. .. | ﬂl

- : Caze | ahels I-IFF oo

= S ourc: Scatterplot Dptluns Fit Line |

TR " |[ Fit Method -
S o e — Contiriue I
| | frearession \",_\_ Lowess Cancel |

= 2 al Eorate b fit (Sl
[C5h| |27 | Buadratic Help
Rl o e

v Tegression H afi iteratiams:
=11} .
' ¢ | Cubicz
2 | regression
— Regreszion Prediction Line(z] Regreszion Optiohz
[ Mean ™ Individual W Include constant in equation

/ Eantdencelnteral (95 &= v Dizplay B-zquare in legend
/4/ A

3.- Hallar la recta de regresion y el valor de R? tal como se hizo antes. El ajuste mejora
notablemente hasta 0,4972 y también ha aumentado el valor de R? Para hallar los
parametros de la recta de regresion (constante y pendiente).
= Menu: File -New — Sintaxis. Escribir:
IF (JCASENUM EQ 31) estatura = 0.

FILTER BY estatura.
GRAPH SCATTERPLOT = estatura WITH peso.

= Menu: Run — All. Se obtiene el siguiente grafico:
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110

100 4§

90 1

80 1

70 +

60 o

50 «

PESO

40 Rsq = 0.4972
130 140 150 160 170 180 190 200

ESTATURA

Determinacion de los pardmetros de la recta de regresion:

» Para hallar los pardmetros de la recta de regresion (constante y pendiente) de la
ecuacion: Y =b + m X

»= Clic sobre el Grafico para seleccionarlo. Luego clic en Analizar—Regresion —
Lineal (Analyze—Regression—Linear).

= Transferir peso como variable dependiente y estatura como variable
independiente. Clic en OK.

» Los coeficientes se muestran en la tabla:

Unstandardized Standardized
Coefficients Coefficients
Model B Std. Beta T Sig.
Error
1 (Constant) -55.831 11.054 -5.051 .000
ESTATURA .788 .066 .705 12.015 .000

a Dependent Variable: PESO
La ecuacion es: PESO = -55,83 + (0,78 * ESTATURA)

El punto de corte con el eje vertical es —55,83 y la pendiente es 0,78.
Nota: Hay dos casos que pueden eliminarse alin para aumentar R* hasta 0,7182

PRACTICA N° 14: GRAFICAS

Obtener las siguientes Graficas a partir del archivo de la Practica N° 04.
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Gréaficos de

Resumenes para grupos de casos

Resumenes para distintas variables

Valores individuales de casos

Barras (Summaries for groups of cases) (Summaries of separate variable) (Values of individual cases)
(Categorias de un grupo en el eje horizontal) (Distintas variables en el eje horizontal) (Casos en el eje horizontal)
BARRAS SIMPLES AGRUPADAS BARRAS SIMPLES DE VARIABLES BARRAS SIMPLES DE CASOS
(Define simple Bar: Summaries for Groups of Cases) (Define Simple Bar: Summaries of Separate Variables) o (Define Simple Bar: Values of Individual Cases)
Simples *
(Simple) o
£ » Norte Este Oeste sur S B Namero de caso
REGION Cociente intelectual PESO ESTATURA
BARRAS AGRUPADAS DE GRUPOS BARRAS AGRUPADAS DE VARIABLES
(Define Clustered Bar:Summaries for Groups of Cases) (Define Clustered Bar: Summaries of Separate Variables)
Agrupadas 5w
(Clustered) g
_§ % rombre
E 9 | | | | [IMujer & . [estatura
Norte Este Oeste sur 2 w0 | [Ceociente intelectual

REGION

Norte Este Oeste sur

REGION
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Apiladas
(Stacked)

300

200

100

Media Cociente intelectual

BARRAS APILADAS DE GRUPOS

(Define Stacked Bar: Summaries for Groups of Cases)

SEXO
|:| Mujer
I:l Hombre
Norte Este Oeste Sur
REGION

Graficos de
Lineas

Resimenes para grupos de casos
(Summaries for groups of cases)

(Categorias de un grupo en el eje horizontal)

Resumenes para distintas variables
(Summaries of separate variable)
(Distintas variables en el eje horizontal)

Valores individuales de casos
(Values of individual cases)
(Casos en el eje horizontal)

Simples
(Simple)

LINEAS SIMPLES DE GRUPOS

(Define simple Line: Summaries for Groups of Cases)

Media PESO

74
Norte Este Oeste Sur

REGION

LINEAS SIMPLES DE VARIABLES

(Define Simple Line: Summaries of Separate Variable)

Cociente intelectual PESO ESTATURA

Valor PESO

110

100

LINEAS SIMPLES DE CASOS

(Define Simple Line: Line Values of Individual Cases)

113 25 37 49 61 73 85 97 109 121 133 145

Numero de caso
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LINEAS MULTIPLES DE GRUPOS

(Define Multiple Line: Summaries for Groups of Cases)

108

106

LINEAS MULTIPLES DE VARIABLES

(Define Multiple Line: summaries of Separate Variable)
180

160

Multiples L
(Multiple £=

LINEAS VERTICALES ENTRE GRUPOS * Ejemplos de Graficas de Sectores.

(Define Drap-Line: Summaries for Groups of Cases) *File > New->» Sintaxis. Luego: Escribir los siguientes comandos:

* *1 Simple de grupos.
) I GRAPH /PIE = COUNT BY region /MISSING=exclude.
Lineas ERS * 2 Estadisticos de grupos.
verticales g w GRAPH /PIE = MEAN(ci) BY region /MISSING=exclude.
(Drop-Line) £ oo * 3 Simple de variables.
u % } * tombre GRAPH /PIE = MEAN(peso estatura)/ MISSING=LISTWISE .

96 4 Mujer
Norte Este Oeste Sur

REGION

Run = All

G r:@ficos de
Areas

Restimenes para grupos de casos
(Summaries for groups of cases)
(Categorias de un grupo en el eje horizontal)

Resumenes para distintas variables
(Summaries of separate variable)
(Distintas variables en el eje horizontal)

Valores individuales de casos
(Values of individual cases)
(Casos en el eje horizontal)
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AREAS DE GRUPOS

(Define Simple Area: Summaries for Groups of Cases)

82

80

AREAS DE VARIABLES

(Define Simple Area: Summaries of Separate Variables)

180

160

* 2.-Simple de sujetos.
GRAPH /LINE(AREA)=VALUE

(peso) .

* 3.-Agrupada de sujetos.

. 140 GRAPH /LINE(AREA)=VALUE
Simples (peso) by sexo .
(SImp'E) ﬁ . 120
o
% 100
% 74
Norte Este Oeste Sur
80
REGION g
]
* Otro ejempIO: 1'-Simp|e de grupos. fociei?e intelectual PESO ESTATURA
GRAPH /LINE (AREA)=COUNT BY region
/IMISSING=exclude.
*DIFERENCIAS .
AREAS APILADAS DE GRUPOS . .
| | AREAS DE VARIABLES AGRUPADAS * 4 _ Areas de diferencias
200 (Define Stacked Area: Summaries for Groups of Cases) (Define Stacked Area: Summaries of Separate Variables) de grupos agru pad a.
300 GRAPH
/LINE(DIFFEREN)=MEAN(ci) BY
region BY sexo
R SRR /IMISSING=exclude.
g 2004
. 2 *5.- Areas de diferencias
Apiladas k5 SEXO i
(Stacked) 8 de variables agrupada.
«© I:lMujer GRAPH
g 0 B Hombre /LINE(DIFFEREN)=MEAN(peso
Norte Este Oeste sur estatura) BY region/

REGION

Media

Norte Este Oeste

REGION

|:|Cociente intel

[ JestaTurA
Sur

MISSING=LISTWISE .

* 6.- Diferencias de
sujetos.

GRAPH
/LINE(DIFFEREN)=N(peso
estatura) by sexo .
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PARETO DE GRUPOS, FRECUENCIAS PARETO DE GRUPOS, SUMA
(Define Simple Pareto: Counts or Sums for Groups of Cases) (Define Simple Pareto: Counts or Sums for Groups of Cases)
160 12000
100 @ F100 cl:j
d o) I3
140 e 100004 z
120 1
80004
100 1
80 o 60001 5o
601 4000
(2]
8404 3481
% o 20007 Iﬂ, 2770 o
3 209 ) [2097]
@ W
L o 0 o 0 . . . . 0
Norte Oeste Este sur Norte Oeste Este Sur
REGION REGION

PARETO APILADA, FRECUENCIAS

(Define Stacked Pareto: Counts or Sums for Groups of Cases)

160
F 100
140 +

Juadiad

120 +
100 «

80 4
k50

SEXO

60 o

Cumulative
|:| Mujer
L0 |:| Hombre

40 +

20 o

Frecuencias

Norte Oeste Este Sur

REGION
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GRAFICAS Resumenes para grupos de casos Resumenes para distintas variables
DE CAJAS (Summaries for groups of cases) (Summaries of separate variable)
(Categorias de un grupo en el eje horizontal) (Distintas variables en el eje horizontal)
180 300
160 o *31
140 I T
200
120
Simple == E g T
(Simples) S & ’
Q
= o= — -
% o %
S I
7 Norte Este Oeste Sur
0
REGION N= 148 148 148
Cociente intelectual ESTATURA PESO
180 300
*31
160 o
140 1 200
o T T
Q93
Clustered 5 1001 100 %
(Ag rU pad aS) ‘g % BCociente intelectual
2 801 B
_E SEXO ESTATURA
Q 0 [Ireso
c 60 1 _— b N= 76 76 76 40 40 40 31 31 31
% Q2 DHom © Alto Medio Bajo
8 40 [ IMujer
N= 27 16 18 20 19 20 11 17 Estatus socioeconémico
Norte Este Oeste Sur
REGION
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GRAFICAS ResUimenes para grupos de casos Resumenes para distintas variables
DE (Summaries for groups of cases) (Summaries of separate variable)
BARRAS (Categorias de un grupo en el eje horizontal) (Distintas variables en el eje horizontal)
DE ERROR
BARRAS DE ERROR SIMPLES *BARRA DE ERROR DE VARIABLES
(Define Simple Error Bar: Summaries for Groups of Cases) GRAPH ERRORBAR(STDDEYV 2)= ci estatura peso.
120
T 11074 S m— S
2
[&]
. a7} - ]
Slmple o !
(Simples) £ 1004 i
Q i 1
c
o -
[&] PR I
S N
QO 901
@)
=S
S 80 . . : :
N= 43 38 39 28
Norte Este Oeste Sur
REGION
*BARRAS DE ERROR DE VARIABLES AGRUPADAS
Clustered *BARRAS DE ERROR AGRUPADAS
(Agrupadas) GRAPH ERRORBAR(STDDEYV 2)= ci estatura peso BY

GRAPH ERRORBAR(STDDEYV 2)= ci BY region BY sexo

region.
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PRACTICA N° 15: PRACTICA CALIFICADA

PRESION ARTERIAL

Se ha disefiado un ensayo clinico aleatorizado, doble-ciego y controlado con placebo, para
estudiar el efecto de dos alternativas terapéuticas en el control de la hipertension arterial. Se
han reclutado 100 pacientes hipertensos y estos han sido distribuidos aleatoriamente en tres
grupos de tratamiento. A uno de los grupos (control) se le administré un placebo, a otro grupo
se le administré un inhibidor de la enzima conversora de la angiotensina (IECA) y al otro un
tratamiento combinado de un diurético y un Antagonista del Calcio. Las variables respuesta
final fueron las presiones arteriales sistolica y diastolica.
Los datos con las claves de aleatorizacion han sido introducidos en una base de datos que
reside en la central de aleatorizacién, mientras que los datos clinicos han sido archivados en
dos archivos distintos, uno para cada uno de los dos centros participantes en el estudio.

Las variables almacenadas en estos archivos clinicos son las siguientes:

Tabla 1.1 Variables en los ficheros con los datos del estudio. (“hipertens — Datos”)

Define variable Type Column Format Labels
Variable |Measurement| Define Width Decimal Column Text Variable
Name (medida) variable (ancho) places width alignment Labels
(Nombre) (Define (Decimales) | (Ancho) | (alineacion) (Rétulo)
variable)

clave Scale numeric 4 0 5 Right Clave de
aleatorizacién

nombre nominal string Characters: 11 Center Iniciales

3

f_nacim scale Date dd.mm.yyyy 11 Right Fecha de
nacimiento

f_inclus scale Date dd.mm.yyyy 11 Right Fecha de
inclusién

sexo nominal Numeric 2 0 5 Right 0:Varén
1:Mujer

altura scale Numeric 8 0 8 Right Altura (cm)

peso Scale Numeric 6 0 8 Right Peso en kg.

pad_ini Scale Numeric 3 0 8 Right Presion
diastdlica
inicial

pad_fin Scale Numeric 3 0 8 Right Presion
diastdlica
final

pas_ini Scale Numeric 3 0 8 Right Presion
sistélica
inicial

pas_fin scale Numeric 3 0 8 Right Presion
sistoélica final

Nota: En la variable sexo. Para Labels. Value: 0 Value label:Varén; Value: 1 Value label:Mujer
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El archivo de claves de aleatorizacion contiene s6lo dos variables.

Tabla 1.2. Variables en el fichero de claves “hipertens — Claves”.

Define variable Type Column Format Labels
Variable | Measure | Define Width | Decimal | Column Text Variable Labels
Name ment variable | (ancho) | places width | alignment (Rétulo)
(Nombre) | (medida) | (Define (Decimal | (Ancho) | (alineacién)
variable) es)
clave Scale numeric 4 0 5 Right Clave de aleatorizacion
Tratamiento aplicado
Value / Value label
: . . 0 /Placebo
FARMACO | nominal | numeric 1 0 5 Right 1/IECA
2 | Ca Antagonista+diurético

La Tabla con los datos relativos a los 10 de los pacientes enrolados en uno de los centros de
investigacion es la siguiente:

Tabla 1.3. Datos de los 10 pacientes reclutados en el centro con 10 pacientes

clave |Nombre | F_macim |F_inclus Sexo |Altura|Peso |Pad_ini |Pad_fin |Pas_ini |Pas_fin
1 SGL 8-9-1941 |13-7-1998 1 165 78 78 104 176 175
2 JCG 10-7-1957 | 9-5-1998 1 154 74 95 114 162 160
3 APZ 18-8-1967 | 1-4-2000 0 156 81 93 102 141 150
4 NDG 8-5-1956 |13-11-1998 0 181 82 86 91 162 161
5 CLO 2-11-1958 | 24-2-1999 1 184 78 89 94 165 162
6 LFZ 13-6-1953 | 16-3-2000 0 179 80 74 99 141 148
7 OAR 20-7-1961 | 21-8-1999 1 159 60 94 95 168 152
8 SGH 6-3-1970 |16-12-1999 0 153 70 94 79 133 143
9 yAWA 6-2-1962 |21-6-2000 1 172 57 74 64 149 135
10 YSJ 5-4-1968 |15-10-1998 0 154 54 89 87 147 155
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Operaciones a realizar con los archivos de datos

Guardar todos los archivos o ficheros dentro de una Carpeta de trabajo que tenga como
nombre su primer nombre y su apellido paterno.

1.

Crear el fichero de datos (Tabla 1.1: Variables) definida con once variables. Luego
introducir los datos de la Tabla 1.3. Grabar este archivo asignandole el nombre
"Apellidos - Datos (1-10)". Revisar bien las 11 variables definidas
Unir o Fusionar (Merge Files) el archivo: "hipertens - Datos (1-100)": Activando el
menu DATA > MERGE FILES > ADD CASES. Seleccionar el archivo: “hipertens —
Datos (11-100)” y clic en Abrir. Observe si se unieron correctamente los datos.
Borrar los casos o filas en blanco del 11 al 21: Seleccionar la columna numerada en la
barra izquierda. Luego Edit > Clear.
Grabar (File > Save as) los datos fusionados (100 pacientes) a un archivo con el
nombre: "Apelidos - Datos (1-100)". Observe los resultados.
Con archivo: Apellidos-Datos (1-100) abierto o activo agregar el archivo "hipertens -
claves aleatorizacion" que contiene la variable Farmaco:
Activando Data - Merge Files - Add Variables. Seleccionar el archivo con las claves
denominado: "hipertens - claves aleatorizacion" y clic en abrir.
Grabar el archivo resultante con el nombre: "Apellidos - Datos+Claves" .
Grabar (o exportar) el archivo “Apellidos-Datos+Claves” que contiene los datos de
todo el estudio (100 pacientes) a diferentes formatos:
« Formato Excel con el nombre: "Apellidos - excel.xIs": FILE - SAVE AS.
En el cuadro de texto desplegable: “Guardar como archivo de tipo” seleccionar
Excel (*.xls).
« Formato con Texto delimitado por tabuladores con el nombre:
"Apellidos - tab.dat" .
En el cuadro de texto desplegable: “Guardar como archivo de tipo” seleccionar:
Tab-delimited (*.dat).
o Formato Texto de ancho fijo con el nombre "Apellidos - fijo.dat"
En el cuadro de texto desplegable: “Guardar como archivo de tipo” seleccionar :
Fixed ASCII (*.dat).
Crear un archivo para cada uno de los grupos de tratamiento. Denominar a estos
archivos "Apellidos - placebo”, "Apellidos - IECA" e "Apellidos - Ca", respectivamente.
(Sugerencia: Utilice la opcion:
m Data—>Select CasesSeleccionar casos)
m  Recuerde que la variable Tratamiento aplicado (farmaco) corresponde placebo = 0;
IECA =1y Ca Antagonista+diurético =2
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Operaciones a realizar con las variables del archivo de datos.

Una vez introducidos, grabados y fusionados los correspondientes archivos de datos, sobre
el archivo completo (con 100 pacientes con los datos clinicos y los farmacos administrados a
cada sujeto), realizar las siguientes operaciones con el archivo: “Apellidos-
Datos+Claves.SAV”:

5. Calcular, para cada paciente al momento del estudio, la edad en afios (redondeando al
entero mas préximo). Denominar la nueva variable "Edad" y etiquetarla
correspondientemente. Releer ejemplos de practicas anteriores sobre calculo con fechas
para utilizar: CTIME.DAYS(fecha) y RDN (EXPRESION NUMERICA). E;j.

RND ((CTIME.DAYS(F_INCLUS)-CTIME.DAYS(F_NACIM)) / 365 )

6.- Recodificar dicha edad de forma que la nueva variable, de nombre clasedad, tome los

siguientes valores. Luego colocar las etiquetas de valor.

Edad en afios || Clasedad E(tlgtéztg)s
Menores de 36 1 "Menores de 36 afios"
De 37 a44 2 “De 37 a 44"
De 45 a 52 3 “De 45 a 52"
Mayores de 52 4 “Mayores de 52"

7. Calcular, para cada paciente, el indice de masa corporal (IMC):
PESO / (ALTURA /100)?
Nota:
m Altura esta dada en centimetros. En la férmula se divide entre 100 para obtener
metros.
m Utilice los botones que se muestran en la opcion del menu Transform->Compute. El
simbolo de potencia es **

Dr. Antonio Alva Santos aalval959@yahoo.es Pag. 58 de 70



Guia de SPSS Facultad de Ingenieria

8. Recodificar dicho indice de masa corporal de forma que la nueva variable, de nombre
obesidad, tome los siguientes valores y etiquetas de valor segun el sexo del paciente.
m (Sugerencia: Data—> Select Cases. Si la condicidon satisface. Si es sexo= 1 (para el
caso de Mujer). Luego: Transform - Recode-> Into different Variables.
m  Grabar como: “Apellidos-Obesidad-Mujer”
m Volver a deseleccionar la opcion activada. Data-> Select cases—> Reset. OK

Sexo IMC ObeMujer Etiqueta
1 Menor de 19 1 “Desnutrida”
19,01 a 24,94 2 “Normal”
24,95 a 29,94 3 “Sobre peso”
29,95 a 39,94 4 “Obesa”
Mayor de 39,95 5 “Muy obesa”

Abrir el archivo de trabajo: “Apellidos-Datos+Claves”

m Sugerencia: Data-> Select Cases. Si la condicion satisface. Si es sexo= 0 (para el
caso de vardn). Luego: Transform - Recode-> Into different Variables.
Grabar como: “Apellidos-Obesidad-Varon”

m Volver a deseleccionar la opcion activada. Data-> Select cases—> Reset. OK

Sexo IMC ObeVaron Etiqueta
0 Menor de 21 1 "Desnutrido”
21,01 a 26,94 2 “Normal”
26,95 a 32,94 3 “Sobre peso”
32,95 a 43,94 4 “Obeso”
Mayor de 43,95 5 “Muy obeso”
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Estadistica descriptiva

Realizar una descripcion de los pacientes enrolados en el estudio. Analizar sus
caracteristicas en el momento de inclusion en el estudio y preparar un visor de resultados
gue contenga exclusivamente los siguientes elementos. Realizar este analisis primero para el
total de la muestra y posteriormente estratificando los resultados por tratamiento recibido.
09.- Frecuencia de varones y mujeres

10.- Para la altura.

m  Determinar las Frecuencias.

m Determinar los estadisticos: Media, Desviacion estandar. Mostrar ademas los
percentiles 25, 50 y 75.

m Grafico: Histograma (Editar el Histograma)

11.- Mediante procedimiento descriptivo determinar para la Altura: N, rango, minimo,
maximo, media, desviacion tipica.

12.- Mediante el procedimiento de estadistica descriptiva: Explorar. Estratificar los resultados
para la variable altura estratificando segun los tratamientos recibidos (Placebo, IECA, Ca
Antagonista+diurético) y, generar graficos como el histograma para Farmaco = Ca
Antagonista+Diurético y el diagrama de cajas y patillas (Altura vs. Tratamiento aplicado).
Editar los graficos.

13.- Determinar los resultados segun la Prueba de Kolmogorov-Smirnov (Sample K-S),

donde, La prueba de normalidad para la variable indice de masa corporal.

14.- Determinar los resultados segun el Procedimiento descriptivo Medias de la variable
indice de masa corporal, estratificando por tratamiento recibido y por sexo de los
pacientes.

15.- Segun la Prueba T de Student para muestras independientes
Mostrar los resultados de la comparacion de las medias de la variable indice de masa
corporal segun el sexo de los pacientes.

16.- Segun la Prueba T de Student para muestras relacionadas determinar los resultados
siguientes se refieren al contraste de la presion arterial sistélica inicial y final del conjunto
de los pacientes

17-. Resultados sobre Caracteristicas basales referidos a las variables Edad en afios,indice
de masa corporal (IMC), presion arterial media inicial; segun tratamiento del conjunto de
los pacientes.

Nota: Presion diferencial = presion maxima o sistolica — presion minima o diastolica

Presion arterial media = presion diastolica + (1/3) x presion diferencial

18.- Resultados sobre Caracteristicas cualitativas basales segun sexo y tratamiento recibido.

RESPUESTAS:

Tras realizar las operaciones planteadas anteriormente, se obtienen los resultados relativos a
las caracteristicas de los pacientes en el momento de la inclusion en el estudio.
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Pregunta 9: Resultados Procedimiento Frecuencias
A continuacion se muestran los resultados del analisis de las variables sexo y altura, obtenidos mediante este
procedimiento, de acuerdo a las siguientes opciones:

= Analyze - Descriptive Statistics = Frequencies. OK

Sexo
Porcentaje Parcentaje
Frecuencia | Porcerntaje walida acumulado
“Alidos  “ardn 54 54,0 54.0 54.0
hibujer L] 4,0 46,0 00,0
Total 100 100,0 100,0

Pregunta 10: Resultados para la Variable ALTURA:
m  Analyze ->Descriptive Statistics> Frequencies. Pasar la variable: Altura
m  Statistics. Seleccionar: Mean, Std. Deviation
m  Percentile(s): 25 (add), 50 (Add), 75 (Add). Continue
m  Charts. Histogram. With normal curve. Continue. OK.

Estadistico Mtura [zm)

Parcentaje Forcentaje
Atura Frecuancia | Porcentaje walido acumulada
N Al 00 Malldes 140 ! 30 3 e
Perdido ] 162 1 1.0 1.0 4,0
. 153 1 1.0 1.0 G,0
hedi 1677 154 3 2D 30 9.0
Cresy. 10,38 155 2 2.0 2.0 11,0
Percertie 25 158,0 198 7 o e 180
167 2 2.0 2.0 20,0
a0 167 0 158 3 3.0 3.0 23,0
75 17510 159 4 4.0 4,0 7.0
160 1 1,0 1.0 8.0
H H H . 161 1 1.0 1.0 a0
Luego de editar el eje Y'y el eje X: 162 2 50 e a0
m  Doble clic en Eje X y en el eje X de la 163 3 3.0 30 340
. .y 164 5 5.0 5.0 0.0
ventanita de edicion. 165 4 40 40 440
m Labels. Orientation: Horizontal. Activar }gg ; ;g ;g ;‘gg
Every. Continue. OK 168 z 20 20 54,0
164 3 3.0 3.0 ar.0
170 4 4.0 4.0 61,0
171 4] a0 a.0 GE,0
Altura (cm) 172 2 20 2.0 B2.0
30 173 4 4.0 4.0 72,0
174 2 2.0 2.0 4.0
174 3 3.0 3.0 7.0
176 1 1.0 1.0 Ta0
o - 177 3 3.0 3.0 1.0
/ 178 2 2.0 2.0 |30
174 3 3.0 3.0 26,0
130 1 1.0 1.0 ar.n
121 1 1,0 1.0 28,0
© 152 1 10 1.0 0.0
[ 183 1 1,0 1.0 ao.,0
.g 184 2 2.0 2.0 a:.0
§ Std. Dev = 10.38 185 3 2.0 2.0 q4.0
g Mean = 167.8 186 1 1,0 1.0 6.0
Lt ° 145.0 155.0 165.0 175.0 185.0 IlQSO noeeee 18? 2 EID EID QSID
’ ’ : ! : 188 1 1,0 1.0 29,0
Altura (cm) 194 1 1,0 1.0 00,0

Total 100 1000 00,0

Dr. Antonio Alva Santos aalval959@yahoo.es Pag. 61 de 70



Guia de SPSS Facultad de Ingenieria

11.- Resultados Procedimiento Descriptivos
La tabla siguiente ha sido producida por este procedimiento de acuerdo a la sintaxis del
cuadro. Se analiza la variable altura.

Estadisticos descriptivos

M Rango Minirmo M axirno Media Desv. tip.
Altura {zrm) 100 47 146 194 167,78 10,38
Mowdlido (sedin lista) 100

Analyze - Reports > Case Summaries

Variables: Altura (cm) [altura]

Desactivar: Display cases

Statistics: Activar Number of cases, Range, Minimum, Maximum,Mean, Standard Deviation
Options: Escriba “Estadisticos Descriptivos” y activar: subheadinng for tottals y exclude cases with
missing values listwise

e Continue. OK

12.-Resultados Procedimiento Explorar
Las tablas siguientes han sido producidas por este procedimiento de acuerdo a la sintaxis del cuadro.
Obsérvese que los resultados se han estratificado segun los tratamientos recibidos.
¢ Analyze - Descriptive Statistics - Explore
Dependent List: Altura (cm) [altura]. En Factor List: Tratamiento aplicado [farmaco]
Plots. Activar Hostogram y desactivar Stem-and-Leaf plots. Continue.
Options: Eclude cases pairwise. Continue y OK.

Descriptivos

Tratamiento Estadistico Error tip.
Altura {crm) Flacebo Media 168,18 1,62
Intervalo de conflanza Lirnite inferior 164,88
parala media al 95% i i
Lirnite superiar 174,48
hedia recartada al 5% 188,00
Mediana 169,00
“YYarianza 86,716
Desy. tip. 9,31
minirmo 1453
Maximo 187
Rango 34
Amplitud intercuartil 16 50
Asirmetria 062 408
Zurtosis -.837 798
IECA Media 168,97 2,02
Intervalo de conflanza Limite inferior 164,86
ara la media al 95% irmi i
P Limite superior 173,08
Media recortada al 5% 168,77
Mediana 169,50
“Warianza 138,878
Desv. tip. 11,78
Minimo 150
Maximo 194
Rango 44
Armplitud intercuartil 1875
Asimetria 154 A03
Curosis - 721 788
Ca Antagonista Media 166,15 1,73
+ Diurético Intervalo de confianza  Limite inferior 162,67
para la media al 99% i i
Lirnite superior 169,62
Media recortada al 5% 166,03
Mediana 165,00
wWarianza 99,258
Desv. tip. o896
minirmo 146
Maximo 187
Rango 41
Amplitud intercoartil 1400
Asimetria 284 408
Curosis 27 a8
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Por altimo, este procedimiento genera graficos como el histograma y el diagrama de cajas y
patillas mostrados en las figuras siguientes.

Histograma
Para FARMACO= Ca Antagonista + Diurético
12
104
g4
6 4
4 4
=
e Desv. tip. = 9,96
o 24
= Media = 166 2
= 0 ] ] i ] ] _|n=33p0
1453 1538 1613 1688 1763 1838
Altura (cm)

e Para editar el grafico anterior: Doble clic en el eje X, luego doble clic en el eje X de la ventana de
edicion.

e Labels. Orientation: Horizontal. Continue

e Custom-> Define . Cambiar: # of interval de 9 a 6. Interval width de 5 a 7.5.

e Continue. OK.

200

1901

1804

1704

1601

1301 4

140 ] , .
M= n M n
Placebo IECA Ca Antagonista + D

Altura (cm)

Tratamiento aplicado
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13.-Resultados Prueba de Kolmogorov-Smirnov (K-S)
La prueba de normalidad para la variable indice de masa corporal se muestra en la siguiente
tabla.

Prueba de Kolmogorov-Smirnov para una muestra

Indice de
masa

corporal

M 100
Parametros normalega.b Media 25,9685
Desviacion tipica 49237

Diferencias mas Absoluta Nirri
extremas Pasitiva 187
MHegativa - 0Ty

Zde Kolmogorm-Smirnoy JT3
Sig. asintdt. (bilateral aa8

a. La distribucidn de contraste es la Mormal.
b. Se han calculado a padir de los datos.

¢ Analyze - Nonparametrics Tests> Sample K-S
e Test variable List: imc. OK

14.-Resultados Procedimiento Medias

A continuacion se muestran los resultados del procedimiento descriptivo Medias de la
variable indice de masa corporal, estratificando por tratamiento recibido y por sexo de los
pacientes.

Informe
Indice de masa corporal
Tratamiento aplicado  Sexo Media I Desy, tip,
Placebo Varan 26,5189 19 50819
Mujer 24,5163 14 4,4598
Total 25 6693 33 485498
IECA Wardn 2545215 19 5,4966
Mujer 25,0789 15 5,2713
Tatal 25,3262 34 85,3214
CaAntagonista + Yardn 26,6190 16 48124
Diurético Mujer 27,2217 17 4,4157
ol 1 266208 33 | 45498
Total Waron 26,1976 54 5,0834
Mujer 25,6996 46 47710
Total 25 8685 100 49237

e Analyze - Compare Means = Means
e Dependent List: imc Independent List: tratamiento aplicado [farmaco].
e Next. Independent List: sexo. OK
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15.-Resultados Prueba T de Student para muestras independientes
En las tablas siguientes se muestran los resultados de la comparacion de las medias de la
variable indice de masa corporal segun el sexo de los pacientes.

Estadisticos de grupo
Desviacion Error tip. de
Sexo N Media tip. la media
Indice de masa corporal  Vardn 54 26,1976 50834 G918
Mujer 46 25 6996 4,7710 4035
FPrueeba de muestras independi entes
Frueba de Levene
para laigualdad de
wananzas Frueba T para la igualdad de medias
G5% Intervalo de
confianza para la
Sig. Diferancia | Erorfip. de diferencia
F Sig. t gl (bilateral) | de mediaz | la diferencia| Inferior Superiar
ndice de masa  Se han asumido
eorparal varianzas Iguales S50 | 460 | s02 93 817 4380 0917 | 14600 | 24850
Mo se han ssumida 505 | 07054 B15 4920 o366 | 14601 | 24561
vatanzas iguales

Analyze—> Compare Means - Independent-Samples T Test

Test Variable(s): imc

Grouping variable(s): sexo (?7?)

Define groups: Grupo 1: 0 Grupo 2: 1. Continue. OK

16.-Resultados Prueba T de Student para muestras relacionadas

Los resultados siguientes se refieren al contraste de la presion arterial sistélica inicial y final
del conjunto de los pacientes

Estadisticos de muestras relacionadas

Desviacidn Error tip. de

Media M tip. la media
Par1  Presion sistolica inicial 162,52 100 1513 1.51
Presian sistdlica final 149,86 100 16,63 1,66

Correlaciones de muestras relacionadas

N Correlacidn Sig.

100 843 oo

FPar1  Presion sistolica inicial
y Presion sistdlica final

Prusba de muestras relacionadas

Diferencias relacionadas

@5% Intervalo de
confianza para la

Desviacion | Emorfip. de diferencia Sig.
Media fip. la media Inferior | Superior i gl |ibilateral)
Far1 Presion sistélica inicial
- Presidn sistélica final 2,66 Q.02 =ln] a7 445 | 2,848 a9 004

e Analyze - Compare Means - Paired Samples T Test

e Seleccionar las variables Presion sistolica inicial y presion sistdlica final y transferirlas amabas
alavez al cuadro de dialogo Paired variables. Luego OK.
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17.-Resultados sobre Caracteristicas basales
Los resultados siguientes se refieren a las variables Edad en afios y Tratamiento del conjunto

de los pacientes
Que luego de editarla, se debe obtener:

Caracteristicas basales

Ca Antagonista +

Flacebo IECA Diurético Total de grupo
Media 50 hedia 50 hedia S0 Media 50
Edad en afios 42,00 (9.76) 44,82 (9,63) 44,03 .71 4363 9 57)
Indige de maza 25 67 (4,26 25,33 (5,32) 26,03 (4,55 25,07 (4,02)
corporal
Presién media inicial 109,36 799 110,79 7 62 108,17 7 .26) 109,79 7 57)

Analyze - Compare Means > Means

Dependent List: edad imc

Independent List: tratamiento aplicado [farmaco]

Options: En Cell Statistics activar: Mean, Standard deviation.

Continue. OK.
Para editar la Tabla: Doble clic sobre la Tabla. Clic en Pivot - Transpose rows and Columns.

18.-Resultados sobre Caracteristicas cualitativas basales sequn sexo y tratamiento
recibido.

Placebo IECA Ca Antagonista +
Diurético
N % n % n %
Sexo Varén 19 57,6% 19 55,9% 16 48,5%
Mujer 14 42 4% 15 44.1% 17 51,5%

Analyze - Descriptive Statistics - Crosstabs
Row(s): sexo (sexo)

Column(s): tratamiento aplicado [farmaco]
Celi(s): Percentages. Activar: Column.
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PRACTICA N° 16: TRABAJO DE APLICACION

SANEAMIENTO AMBIENTAL
1.- ¢Suvivienda es?
Propia ( )

Alguilada ( )
Otrosl

Especifique
2.- ¢ El material de construccion
de su vivienda es?

Material Noble ( )
Adobe ()
Cafia ()
Estera ( )

Triplay ( )
Otros?2

3.- ¢ Cuantas habitaciones tiene:
NuUmero:

Dormitorios ( )
Bafios ()
Cocina ()
Sala ()
Comedor ()
Otros3

Especifique

4.- ¢Cuantas personas duermen
por dormitorio?
Numero:

5.- ¢Suvivienda cuenta con
jardin?
SI() NO ()

Il SERVICIOS BASICOS DE
SALUBRIDAD

6.- ¢Como se abstece de agua?
Red Intradomiciliaria
Pileta ( )
Pozo ()
Otros6

Especifique

10.

11.

12.

13.

¢En qué almacena el agua?
Cisterna ()

Cilindro ()

Balde ( )

Lata ( )

Otros7

¢Hierve el agua que toma?

SI() NO ()

¢,Cuenta con energia eléctrica?

SI() NO (1)

Horario
¢,Donde elimina sus excretas?

Desague ( )

Letrina ()

Otros10

¢, Como desecha su basura?
Camion de basura ()
Arrojan al campo ( )

La queman ( )
Contenedor ()

Otrosl11l

¢, Qué animales domésticos tiene en
su vivienda?

Aves ()

Perros ()

Gatos ()

Cerdos ()

Otros12

¢,Qué animales ftransmisores de
enfermedades existen en su
vivienda?

Moscas ( )

Roedores ()

Cucarachas ( )

Zancudos ( )

Pulgas ( )

Otros13
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IV. ASPECTOS DE SALUD

14.

15.

16.

17.

18.

19.

¢, Cuales son los sintomas y signos
mas frecuentes de enfermedades
gue ha sufrido su familia?
SINTOMA  TIEMPO DE
DURACION

Tos:

Diarrea:

Fatiga:
Silbido pecho:
Ardor al orinar:
Dolor de cabeza :
Granos:

Picazon:

Otros14

Especifique

¢Cuando algin miembro de su
familia enferma, a donde acude?

Puesto de Salud ()
Centro de Salud ( )
Hospital ()

Centro Particular ( )
Farmacia ( )
Botica ( )
Curandero ( )

¢Algun miembro de su familia
fuma?

SI()

Cuantos:

NO (')

¢Algun miembro de su familia

ingiere licor? SI() NO()
Cuéntos:

¢Cuantas veces al mes ingiere
licor?

(0)(1)(2)(3)(4) (+de4)

¢Alguien de su familia ha fallecido
en el presente afio que residid en
su hogar?
SI()
Edad:
Causa:

NO ()

20.

21.

22.

23.

Guia de SPSS Facultad de Ingenieria

¢En el presente afio ha nacido
alguien en su familia?
SI() NO ()
Especifigue elsexo: F() M ()
¢, Qué método de planificacion
familiar usa?
Anticonceptivos:

Orales () Locales ()

Intramusculares ( )
Quirdrgicos

Vasectomia ( )

Ligadura de trompas ( )
Método Natural:

Billing ( ) Regla ()
Ninguno ( )
¢Hay gestantes en su hogar?
SI() NO()

Si su respuesta es Sl:
a) Tiene control de embarazo
SI() NO()
b) Estavacunada contra el tétano.
SI() NO()
c¢) ¢Donde se atendio el dltimo parto?
Hospital ()
Domicilio ()
Otros22

Especifique
¢ Estan vacunados sus hijos?
SI() NO()
Si estan vacunados, contra qué?
Sarampién ()
Tosferina ()
TBC ()
Tétano ()
Polio ()
Otros23 () Verificar Tarjeta
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NUTRICION

24. ;Qué alimentos consumen durante
la semana?
Pescado ( ) Frutas ()
Carne () Mantequilla ( )
Pollo( ) Pan ()

25. ¢Cuantas veces al dia se
alimentan?
N°:

D A L C
() ) )y )

V. ASECTOS SOCIOECONOMICOS
27. ¢Pertenece a alguna asociacion de
base? SI() NO ()
Club de Madres ()
Vaso de Leche ( )
Comedor Popular ()
Otros27

Especifique
28. ¢Qué tipo de informacion escrita
prefiere?

Libro ()
Revista ( )
Periddicos ()
Otros28

29. ¢Qué tipo de musica prefiere?
Chicha () Salsa ()
Rock ()

Otros29:

26.

30.

31.

Guia de SPSS Facultad de Ingenieria

¢Qué medio utiliza para la coccion de
sus alimentos?

Lefia () Carbon ()
Kerosene () Gas ()
Electricidad ()

Otros26

¢ Cuéntas personas trabajan en su familia?

N°:

¢ Qué artefactos eléctricos posee?

V()

Video ( )
Radio ()
Cocinaa Gas ( )
Refrigerador ( )
Otros31
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32.

33.

34.

35.
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¢Cada qué tiempo le pagan? 36. ¢Cuantos de sus hijos terminaron de
estudiar el presente afio?

Diario () Quincenal () ¢Cuéntos?

Semanal () Mensual ()
Inicial ()

¢ Cuél es ingreso econémico Primaria ()

familiar? Secundaria ()
Superior ()

S/.

<250 ()

250 - 500 ()

500 -1000 ( )

1000 - 3000 ( )

> 3000 ()

¢Cuanto gasta en alimentos

mensualmente? 37. ¢(El medio de transporte que utiliza
diariamente para movilizarse es?

S/. PROPIO () NOPROPIO ()

¢En qué tipo de colegio estudian

sus hijos?

Nacional ()

Particular ()

A PARTIR DE LOS DATOS RECOLECTADOQS:

© © N o gk~ 0w DN RE

Definir las variables y grabar el archivo como: XXXXXXXX ( Escriba un nombre maximo
con 8 caracteres). Luego realice el andlisis de los datos y los gréficos que le faciliten
responder las siguientes preguntas:

Frecuencia de tipo de vivienda

Promedio de material de construccion de las viviendas

Numero de habitaciones promedio

Numero de dormitorios / casa

Numero de bafios / casa

Promedio del niumero de personas que duermen por dormitorio

Promedio de numero de hijos por familia

Promedio de jardines por casa

Frecuencia de abastecimiento de agua
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10. Frecuencia de almacenamiento de agua

11. Frecuencia de viviendas con energia eléctrica

12. Frecuencia de eliminacion de excretas

13. Frecuencia de formas para desechar la basura

14. Frecuencia de animales domésticos en las viviendas

15. Frecuencia de animales transmisores de enfermedades en las viviendas

16. Frecuencia de enfermedades de sintomas y signos

17. Frecuencia de asistencia de las personas al enfermarse

18. Frecuencia de personas que fuman

19. Frecuencia de personas que ingieren licor

20. Frecuencia al mes de personas que consumen licor

21. Frecuencia de personas que han fallecido

22. Tabla de nacimiento segun sexo

23. Frecuencia de método de planificaciobn segun anticonceptivos, quirdrgicos y
meétodo natural

24. Frecuencia de gestantes en su hogar

25. Frecuencia de personas vacunadas

26. Frecuencia de consumo de alimentos

27. El medio mas comun de coccion de los alimentos

28. Institucién a la que pertenecen

29. El tipo de informacion escrita de mayor preferencia

30. La musica de mayor preferencia

31. Niomero de personas que trabajan

32. El artefacto eléctrico mas comun

33. El tiempo de pago

34. El ingreso econémico promedio

35. El promedio de gastos en alimentos

36.Tipo de colegio mas comun en la cual estudian los hijos

37. Niumero de Hijos que concluyeron estudios

38. El medio de transporte mas comun
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UNIVERSIDAD PRIVADA SAN PEDRO
FACULTAD DE MEDICINA HUMANA - ESCUELA DE MEDICINA

EVALUACION DEL LOGRO DE LAS COMPETENCIAS BASICAS
EN EL MANJEO DE SOFWTARE ESTADISTICO”

AlUMNO(A): oottt ie e e e e e e e e e e e e e e e e s tnbreeeeeeeeeeanens CoOdigo: .eoeeeeieiiee e,
PCN°® .., Ciclo: I'l Grupo: ............. Semestre: ........ccovvveeee.

Instrucciones: Esta evaluacion para el manejo de un paquete informatico, sé6lo tiene dos dominios de
evaluacion: Si cuando se tenga el manejo o dominio de la habilidad ( 1 punto cada Si) y No cuando el manejo
sea deficiente o nulo (0 puntos)

I. Crea variables adecuadas para un cuestionario ya aplicado Si No

1. Define en el computador las variables del cuestionario segun tipo, formato de columna,
etigueta, valores perdidos o datos en blanco.

2. Describe la variable en los casos en que el nombre de la variable no sea autoexplicativo
0 se requiera una explicacion mas detallada.

Il. Introduce y reingresa datos de todo tipo como paso previo para realizar un analisis
de los datos.

3. Registra los datos por filas o columnas

4. Toma decisiones para registrar o no los datos provenientes de cuestionarios que sean
dudosos o ilégicos, utilizando el valor definido en la variable definida para estos casos.

5. Evita errores al registrar datos

6. Une archivos afladiendo nuevos casos o nuevas variables

Ill. Realiza el andlisis de los datos.

Creando y transformando las variables, mediante la:
a) Recodificacién de variables
b) Creacién de nuevas o tranformando las ya existentes utilizando operadores
diversos
c) Creacion de nuevas variables o de nuevos valores a variables existentes si una
determinada condicién se cumple

Segmenta archivos para analizar datos de grupos por separado

©|

Selecciona casos 0 una parte de los sujetos para realizar el analisis
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IV. Examina las variables de una manera bastante exhaustiva

10. Describe variables de tipo:
a) Nominales: Moda
b) Ordinales: mediana, rango, maximo, minimo
c) De Intervalo: Histograma, media, desviacion std, rango, coeficientes

V. Relaciona variables con indices estadisticos mediante:

11.Tablas de contingencia

12. Coeficiente de correlacion de Pearson entre dos variables cualitativas

13. Unarepresentacion grafica (nube de puntos) de larelacién entre dos variables
editando la gréfica para hallar larecta de regresién y sus parametros (constante y
pendiente)

VI. Obtiene y edita Gréficas de diferentes tipos que representan adecuadamente los
datos y facilitan su interpretacion.

14. De barras

15. De lineas

16. De area y diferencias de medias

17. De Sectores

18. De Pareto

19. De Cajas

20. De barras de error
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